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Related Manuals 
 
Here is a list of related manuals that you may find helpful:  
 

Clinical Procedures Installation Guide 
Clinical Procedures Technical Manual and Package Security Guide 
Clinical Procedures User Manual 
Clinical Procedures Release Notes 
CPRS User Guide: GUI Version 
CPRS Setup Guide 
Consult/Request Tracking User Manual 
Consult/Request Tracking Technical Manual 
Text Integration Utilities (TIU) Implementation Guide 
Text Integration Utilities (TIU) User Manual 
VistA Imaging System (Clinical) User Manual 

  
These manuals can be found in the VistA Documentation Library (VDL), 
http://www.va.gov./vdl.  Select Clinical from the VDL web page, select the package you want, 
and then select the manuals.  For example, you can select CPRS on the left side of the page.  The 
list of CPRS manuals is displayed. 
 
1You may also want to read the CP Implementation Process (Webpage), which is available on 
the CP website. Go to http://vista.med.va.gov/ClinicalSpecialties/clinproc/. 
Point to Clinical Procedures Project, then click Documentation.  When the Documentation 
page displays, click Clinical Procedures Documents, then click The CP Implementation 
Process (Webpage). This list includes a high-level step-by-step guide to the installation and the 
implementation process.  
 

                                                 
1 MD*1.0*14  March 2008  Changed document name from “Site Installation Checklist” to “The CP Implementation 
Process (Webpage).” Revised directions to access the document. 
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General CP Package Information 
 
1.  Name spacing and file listing. 
 

Clinical Procedures is found in the MD namespace.  All routines, templates and options begin 
with MD.  File numbers range from 702 to 704 and are stored in the ^MDD and ^MDS globals.  
The range of 704.201 to 704.209 is stored in the ^MDK global.  Here is a list of the Clinical 
Procedures files: 
 

#702 CP Transaction 
#702.01 CP Definition 
#702.09 CP Instrument 
#703.1 CP Result Report 

 
2.  Queuing TaskMan jobs. 
 
Queued TaskMan jobs are not associated with this application. 
 
3.  Accessing modules. 
 

• Assign the option [MD GUI USER] to the clinical staff, who need access to CP User.   
 

• Assign the option [MD GUI MANAGER] to the Clinical Application Coordinator, CP 
package coordinator, and Information Resource Management Service (IRMS) staff for 
access to CP Manager.  
 

• Assign the MD MANAGER key to the Clinical Application Coordinator or the CP 
Package Coordinator.  This key controls access to the Update Study Status menu option 
that allows clinicians to fix study errors. This key also controls access to the Delete Study 
option.  
 

• Assign the MAGCAP CP user security key to technicians, who will be using VistA 
Imaging to capture a consent form and link it to a CP study or TIU document.  

 
4.  Printer issues. 
 
All reports are printed to Client (Windows) printers. 
 
5.  Online Help. 
 
Online help is available when questions arise.  Click Help or choose Help from the menu bar.  
You can also press F1 for help on a specific window. 
 
6.  Automatic Version Updates. 
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CP applications (client and server) do not contain automatic update capabilities.  You must 
remove the previous version before you can install the new version.   
 
7.  Command line switches. 
 
For alternate methods of running Clinical Procedures, refer to Appendix A - CP Application 
Startup Options and Command Line Switches, p. 15-1. 
 
 
Resource Requirements 
 

• Clinical Procedures can only run at sites that are running VistA Imaging V. 3.0.   
 

• Workstations must run Windows 2000 or later.  12 MB of available disc space is 
required.  

 
VistA Server resources: 

 
 Globals Type of Data Size
 
 ^MDS Static global 25 k 
 
 ^MDD Patient data for the 25-75 k/patient 
  Clinical Procedures  
 
 ^MDK Hemodialysis Studies 25-75 k/patient 
 

NOTE:  These globals must all be journalled. 
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Hospital Location File Requirement (Implementing Workload 
Reporting) 
 
Be sure that the hospital location entry (Hospital Location #44 file) for each CP procedure 
contains the correct Institution field entry.  The Hospital Location is used for workload 
reporting. (The Institution field tells VistA Imaging where to store the images on the server. If 
there is no Institution field, CP defaults to the institution of the user who logged on to CP 
Gateway.) 
 
VistA Imaging 
 
Providers at a site must use the VistA Imaging Display client to view CP results and reports. Be 
sure that VistA Imaging V.3.0 or greater and Patch 7 of Imaging V.3.0 (MAG*3.0*7) are 
installed. 
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4. Setting Up TIU for Clinical Procedures 
 
This chapter describes the steps to follow to set up TIU for CP. The purpose of setting up TIU is 
to design the CP document hierarchy that creates the TIU document title, which is displayed to 
an authorized “Interpreter.”  The procedures in this section describe how to configure the new 
Clinical Procedures Class in TIU.  Be sure to follow these steps in sequential order.   
 
Topics discussed in this chapter are: 
 

• Step 1 – Verify Clinical Procedures Class Upload Header 
• Step 2 – Create CP Class Document Definitions 
• Step 3 – Define Clinical Procedures Class Document Parameters 

 
Note:   Be sure the TIU Enhancement for Clinical Procedures patch (TIU*1*109) is installed 
before you set up TIU. 
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Step 1 - Verify Clinical Procedures Class Upload Header 
 
The Upload Utility option displays information about how headers are formatted for dictated 
documents, which are transcribed offline and uploaded into VistA.  This option also displays 
"blank" character, major delimiter and end of message signal as defined by your site.  If the 
Clinical Procedure CLASS output does not match Figure 4-1, check to see if the TIU*1.0*109 
patch was installed.  The upload header for the Clinical Procedures Class is automatically set up 
when the TIU*1.0*109 patch is installed.  
 
1 To verify that the upload header is appropriately defined for the Clinical Procedures Class, use 
the option [TIU UPLOAD HELP]. The output will look something like this: 
 

Upload Utility: Access the following option: 
Help for Upload Utility [TIU UPLOAD HELP] 
Select DOCUMENT DEFINITION: CLINICAL PROCEDURES   CLASS  
 
$HDR:                                     CLINICAL PROCEDURES 
TITLE:                                    GENERAL PROCEDURE 
SSN:                                      666-12-1234 
VISIT/EVENT DATE:            5/15/2001@08:15 
AUTHOR:                                 CPRSPROVIDER,ONE 
DATE/TIME OF DICTATION:       5/16/2001@09:25 
LOCATION:                               MEDICAL-CONSULT 6200 
EXPECTED COSIGNER:               CPRSPROVIDER,TWO 
CONSULT REQUEST NUMBER:    1455 
TIU DOCUMENT NUMBER:         543 
PROCEDURE SUMMARY CODE:  Normal 
DATE/TIME PERFORMED:         5/15/2001@08:00 
$TXT 
 CLINICAL PROCEDURES Text 
 
 
*** File should be ASCII with width no greater than 80 columns. 
*** Use "@@@" for "BLANKS" (word or phrase in dictation that isn't understood). 
 

Fig. 4-1 

 

                                                 
1 Patch MD*1.0*14  March 2008  Output display changed. 
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Step 2 - Create CP Class Document Definitions 
 
You need to create CP document classes and titles.  A Document Definition provides the 
building blocks for the TIU package.  A Document Definition organizes a document into a 
hierarchical structure.  This structure allows documents to inherit characteristics such as 
signature requirements and print characteristics from the higher levels, including Class and 
Document Class.  A Document Definition also lets you create and use boilerplate text, embedded 
objects, and CPRS templates.  
 
Types of Class Document Definitions: 
CL Class – Main class of documents, such as Clinical Procedures. 
DC Document Class – Categories of documents with related characteristics, such as CP 

Cardiology, CP GI. 
TL Title – TIU note title, such as CP EKG. 
 
To implement Clinical Procedures, your facility must set up new document definitions for the 
Clinical Procedures Class within TIU.   
 
The CLINICAL PROCEDURES CLASS is installed with patch TIU*1.0*109 and is 
automatically set to Active.  
 
It is strongly recommended that you create Clinical Procedures Titles and Document 
Classes with the “CP” prefix.  This will avoid confusion with previously created Titles and 
Document Classes.  Only documents under the CP class have the CP functionality. 
 
To construct a new document definition sub-tree for Clinical Procedures, do the following: 
 

1. Go into the TIU IRM Maintenance menu. 
2. Select Document Definitions Manager  > Create Document Definitions.  
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A screen similar to the following is displayed.  (An example of the hierarchy is shown here.  On 
your screen, the levels under Clinical Procedures will not show):  
 
Create Document Definitions     May 07, 2003@09:03:57      Page:    1 of  1 
------------------------------------------------------------------------------ 
                               BASICS 
           Name                                       Type 
------------------------------------------------------------------------------ 
1 CLINICAL DOCUMENTS                             CL 
2   DISCHARGE SUMMARY                           CL 
3   PROGRESS NOTES                                CL 
4   ADDENDUM                                      DC 
5   CLINICAL PROCEDURES                           CL 
6     CP CARDIOLOGY                             DC 
7       CP PULMONARY FUNCTION TEST      TL 
8       CP EKG                                    TL 
9     CP GI TESTS                                 DC 
10       CP ENDOSCOPY                             TL 
11       CP COLONOSCOPY                           TL 
12     CP HEMATOLOGY                               DC 
13       CP BONE MARROW                           TL 
14     CP RHEUMATOLOGY                             DC 
 
------------------------------------------------------------------------------ 
         ?Help   >Scroll Right   PS/PL Print Scrn/List   +/-          >>> 
------------------------------------------------------------------------------ 
  (Title)   Restart   Status... 
  (Component)  Boilerplate Text  Delete 
Select Action: Next Level//  
 
The above example suggests a Service oriented set of Document Classes with one or more Titles 
under each.  You need to work with your Clinical Application Coordinator (CAC), IRMS, and 
the Consulting Services to develop a complete set of Document Definitions for Clinical 
Procedures. 
 
To view a list of already existing titles, use the Next Level option to expand the class you want 
to view. 
 
You may have to navigate down the hierarchy to add Document Classes or Titles.  The following 
are examples of going to other levels, creating a document class, and creating a title.  
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Example of going to the next level: 
 
Create Document Definitions     May 07, 2003@09:03:57      Page:    1 of  1 
------------------------------------------------------------------------------ 
                               BASICS 
           Name                                       Type 
------------------------------------------------------------------------------ 
1 CLINICAL DOCUMENTS                             CL 
2   DISCHARGE SUMMARY                           CL 
3   PROGRESS NOTES                                CL 
4   ADDENDUM                                      DC 
5   CLINICAL PROCEDURES                           CL 
 
------------------------------------------------------------------------------ 
         ?Help   >Scroll Right   PS/PL Print Scrn/List   +/-          >>> 
------------------------------------------------------------------------------ 
  (Title)   Restart   Status... 
  (Component)  Boilerplate Text  Delete 
Select Action: Next Level// <RET>  Next Level 
Select CLINICAL DOCUMENTS Item (Line 2-5): 5...........  (Clinical Procedures 
level) 
 
Create Document Definitions     May 07, 2003@09:03:57      Page:    1 of  1 
------------------------------------------------------------------------------ 
                               BASICS 
           Name                                       Type 
------------------------------------------------------------------------------ 
1 CLINICAL DOCUMENTS                             CL 
2   DISCHARGE SUMMARY                           CL 
3   PROGRESS NOTES                                CL 
4   ADDENDUM                                      DC 
5   CLINICAL PROCEDURES                           CL 
6     CP CARDIOLOGY                             DC 
7     CP GI TESTS                                 DC 
8     CP HEMATOLOGY                               DC 
9     CP RHEUMATOLOGY                             DC 
 
------------------------------------------------------------------------------ 
         ?Help   >Scroll Right   PS/PL Print Scrn/List   +/-          >>> 
------------------------------------------------------------------------------ 
  (Title)   Restart   Status... 
  (Component)  Boilerplate Text  Delete 
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Example of creating a Document Class: 
 
Select ACTION: CLASS   Class/DocumentClass   
Enter the Name of a new CLINICAL PROCEDURES: CP NEUROLOGY 
TYPE: (CL/DC): DC  DOCUMENT CLASS 
CLASS OWNER: CLINICAL COORDINATOR  Replace   <RET> 
STATUS: (A/I): INACTIVE// A  ACTIVE 
SEQUENCE: <RET> 
MNEMONIC: <RET> 
MENU TEXT: CP Neurology// <RET> 
 
Entry Created 
 
Create Document Definitions     May 07, 2003@09:03:57      Page:    1 of  1 
------------------------------------------------------------------------------ 
                               BASICS 
           Name                                       Type 
------------------------------------------------------------------------------ 
1 CLINICAL DOCUMENTS                             CL 
2   DISCHARGE SUMMARY                           CL 
3   PROGRESS NOTES                                CL 
4   ADDENDUM                                      DC 
5   CLINICAL PROCEDURES                           CL 
6     CP CARDIOLOGY                             DC 
7     CP GI TESTS                                 DC 
8     CP HEMATOLOGY                               DC 
9     CP RHEUMATOLOGY                             DC 
10     CP NEUROLOGY                             DC 
 
------------------------------------------------------------------------------ 
         ?Help   >Scroll Right   PS/PL Print Scrn/List   +/-          >>> 
------------------------------------------------------------------------------ 
  (Title)   Restart   Status... 
  (Component)  Boilerplate Text  Delete 
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Example of creating a Title: 
 
You must go to the appropriate level before a Title can be added. 
 
Select Action: Next Level// <RET>  Next Level 
Select CLINICAL DOCUMENTS Item (Line 6-10): 10...........  (CP NEUROLOGY 
level) 
 
Create Document Definitions     May 07, 2003@09:03:57      Page:    1 of  1 
------------------------------------------------------------------------------ 
                               BASICS 
+          Name                                       Type 
------------------------------------------------------------------------------ 
2   CLINICAL PROCEDURES                           CL 
3     CP NEUROLOGY                             DC 
 
------------------------------------------------------------------------------ 
         ?Help   >Scroll Right   PS/PL Print Scrn/List   +/-          >>> 
------------------------------------------------------------------------------ 
  (Class/DocumentClass) Next Level   Detailed Display/Edit 
  Title   Restart   Status... 
  (Component)  Boilerplate Text  Delete 
 
At this point a Title may be added. 
 
Select Action: Title//    Title   
 Enter the Name of a new NEUROLOGY: CP PSEUDOFOLLICULAR SCAN 
CLASS OWNER: CLINICAL COORDINATOR  Replace   <RET> 
1EVERY Local Title must be mapped to a VHA Enterprise Standard Title. 
      (See example in the following section: “Example of New TIU Prompts”) 
STATUS: (A/I/T): INACTIVE// A  ACTIVE 
SEQUENCE: <RET> 
MENU TEXT: CP Pseudofollicular Scan  Replace <RET> 
 
Entry Created 
 
If you wish, you may enter another CP NEUROLOGY 
 
Create Document Definitions     May 07, 2003@09:03:57      Page:    1 of  1 
------------------------------------------------------------------------------ 
                               BASICS 
+          Name                                       Type 
------------------------------------------------------------------------------ 
2   CLINICAL PROCEDURES                           CL 
3     CP NEUROLOGY                             DC 
4       CP PSEUDOFOLLICULAR SCAN                  TL 
 
------------------------------------------------------------------------------ 
         ?Help   >Scroll Right   PS/PL Print Scrn/List   +/-          >>> 
------------------------------------------------------------------------------ 
  (Title)   Restart   Status... 
  (Component)  Boilerplate Text  Delete 

                                                 
1 Patch MD*1.0*14  March 2008  New prompts added. 
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Select Action: Next Level//  
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1Example of New TIU Prompts 
Several new TIU prompts display as each word of the new TIU note title is run through a series 
of checks against the national list.  
 
In the following example, the name of the new TIU note title is “CP HEMOTEST.” 
 
EVERY Local Title must be mapped to a VHA Enterprise Standard Title. 
 
Remember, your LOCAL title is: CP HEMOTEST 
Attempting to map CP HEMOTEST 
  to a VHA Enterprise Standard Title... 
 
Is "CP" a Subject Matter Domain? No. 
Is "CP" a SYNONYM for a Subject Matter Domain? No. 
 
Is "HEMOTEST" a Subject Matter Domain? No. 
Is "HEMOTEST" a SYNONYM for a Subject Matter Domain? No. 
 
Is "CP" a LOINC Role? No. 
Is "CP" a SYNONYM for a LOINC Role? No. 
 
Is "HEMOTEST" a LOINC Role? No. 
Is "HEMOTEST" a SYNONYM for a LOINC Role? No. 
 
Is "CP" a Setting? No. 
Is "CP" a SYNONYM for a Setting? No. 
 
Is "HEMOTEST" a Setting? No. 
Is "HEMOTEST" a SYNONYM for a Setting? No. 
 
Remember, your LOCAL title is: CP HEMOTEST 
Is "CP" a Service? No. 
Is "CP" a SYNONYM for a Service? No. 
 
Is "HEMOTEST" a Service? No. 
Is "HEMOTEST" a SYNONYM for a Service? No. 
 
Is "CP" a Document Type? No. 
Is "CP" a SYNONYM for a Document Type? No. 
 
Is "HEMOTEST" a Document Type? No. 
Is "HEMOTEST" a SYNONYM for a Document Type? No. 
 
AUGH! Let's try a manual look-up... 
Again, your LOCAL Title is: CP HEMOTEST 
 
  NOTE: Only ACTIVE Titles may be selected... 
 
Select VHA ENTERPRISE STANDARD TITLE: DIALYSIS NOTE   
    I found a match of: DIALYSIS NOTE 
         ... OK? Yes//   YES 
 
     Ready to map LOCAL Title: CP HEMOTEST to 
VHA Enterprise Standard Title: DIALYSIS NOTE. 
         ... OK? Yes//   YES 

                                                 
1 Patch MD*1.0*14  March 2008  Update with new TIU prompts example to reflect TIU field change. 
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             Done. 
In the example above, “DIALYSIS NOTE” was selected as the VHA Enterprise Standard Title.  
You may use DIALYSIS NOTE as your title, but you are not required to do so.  If another title 
from the VHA Enterprise Standard Title list is more appropriate for your site, you may select it 
from the list. 
 
Step 3 - Define Clinical Procedures Class Document Parameters 
 
You need to define a set of document parameters for the new CP Class.  
 

1. Go into the TIU Maintenance Menu. 
2. Select TIU Parameters Menu > Document Parameter Edit. 

 
Note: (Entries in parentheses are recommended values.) 
 

Parameters: Access the following menu: 
TIU IRM Maintenance Menu [TIU IRM MAINTENANCE MENU] 
      TIU Parameters Menu [TIU SET-UP MENU] 

Document Parameter Edit [TIU DOCUMENT PARAMETER EDIT] 
Select DOCUMENT DEFINITION: CLINICAL PROCEDURES   CLASS  
DOCUMENT DEFINITION: CLINICAL PROCEDURES//  <RET> 
REQUIRE RELEASE:                 (NO) 
REQUIRE MAS VERIFICATION:        (NO)  
*REQUIRE AUTHOR TO SIGN:         (YES)  
ROUTINE PRINT EVENT(S):  
STAT PRINT EVENT(S):  
MANUAL PRINT AFTER ENTRY:        (NO)  
ALLOW CHART PRINT OUTSIDE MAS:   (YES)  
*ALLOW >1 RECORDS PER VISIT:     (YES)  
ENABLE IRT INTERFACE:  
*SUPPRESS DX/CPT ON ENTRY:       (NO)  
FORCE RESPONSE TO EXPOSURES:  
*ASK DX/CPT ON ALL OPT VISITS:   (YES)  
SEND ALERTS ON ADDENDA:  
ORDER ID ENTRIES BY TITLE:  
SEND ALERTS ON NEW ID ENTRY:  
SEND COSIGNATURE ALERT: 
EDITOR SET-UP CODE:  
If document is to be uploaded, specify Filing Alert Recipients: 
Select FILING ERROR ALERT RECIPIENTS: <identify local recipients as 
appropriate>  
Now enter the USER CLASSES for which cosignature will be required: 
Select USERS REQUIRING COSIGNATURE: <identify local recipients as 
appropriate> 
Now enter the DIVISIONAL parameters: 
Select DIVISION:  

CHART COPY PRINTER:  
STAT CHART COPY PRINTER:  

 
Note: You must set parameters marked with an asterisk ‘*’.  If a response is not entered for a 
particular parameter, the default value is ‘No’. 
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6. Setting Up Clinical Procedures 
 
This chapter describes how to set up CP procedures, instruments, and system parameters.  It is 
recommended that you follow these steps in sequential order.  Topics discussed in this chapter 
include: 
 

• Step 1 – Populate the CP Definition file 
• Step 2 – Setting Up Instruments 
• Step 3 – Setting Up Procedures 
• Step 4 – Setting Up System Parameters 

 
 
Step 1 - Populate the CP Definition (#702.01) file  
 
You can populate the CP Definition (#702.01) file with names of clinical procedures 
automatically by running the INIT^MDPOST routine, and manually by using the procedure edit 
screen.  Editing the procedures is described in detail later in this chapter. 
 
Before you decide which method to use, review Appendix B – Exported Procedures List, p. 16-1, 
for the list of procedures.  If the Clinical Application Coordinator (CAC) and the CP package 
coordinator decide to use these procedures for the medical center, IRM can run INIT^MDPOST 
to automatically populate the CP Definition file with a list of known procedures.  These 
procedure definitions are not complete and must be edited using CP Manager to make them work 
properly.  Additional procedures can also be added using CP Manager.   
 
The application coordinators may initially populate the file manually and then run the 
INIT^MDPOST routine at a later time.  This routine does not overwrite the existing data in the 
CP Definition file; it adds procedures that are not in the current CP Definition file.  
 
All procedures are stored in a subfolder called Unassigned within the Procedures folder.  All 
procedures are initially tagged inactive.  Use CP Manager to activate specific procedures and 
associate the procedures with treating specialties.  
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Step 2 – Setting Up Instruments 
 
Information on instruments is not complete after instrument information is added during 
installation.  You must go into CP Manager and enter the necessary fields before the 
package will work successfully. 
 
To access CP Manager: 
 

1. Double-click CP Manager on the desktop.  
2. Enter your access and verify codes. 
3. Click OK. The following main screen is displayed: 

 

 
Figure 6-1 
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In most cases, you edit an existing automated instrument.  The Mallinckrodt Clinivision, 
Olympus Endoworks, GE Medical Systems Muse and Viasys/Sensormedics Vmax automated 
device interfaces are exported with Clinical Procedures.  You must edit all the automated 
instruments that you want to implement with necessary information. 
 
 
Editing an Automated Instrument 
 
The following list of fields applies to automated instruments: 
 
* indicates fields that must be filled in for an active instrument to work properly. 
 
BOLD indicates fields that are already populated when an automated instrument is exported.  
 
∗ Instrument Name 
∗ Printable Name 
Description 
∗ M Routine 
∗ Pkg. Code 
∗ Valid Attachment Types 

 
If Bi-Directional Instrument is checked: 
 

∗HL7 Inst ID  
∗HL7 Link 
 

∗ Notification Mailgroup 
∗ Active 
Serial Number (Optional) 
Delete When Submitted (Optional) 
Default Extension (Optional) 
IP Address  (Optional) 
Port  (Optional) 
HL7 Unv Svc ID  (Optional) 
Server Name  (Optional) 
Share Name  (Optional) 
Path Name  (Optional) 
Executable Name  (Optional) 
 
 
To edit an automated instrument: 
 

1. View the list of automated instruments.  See Figure 6-2. 
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2. Click on an automated instrument.  The edit screen is displayed on the right side of the 
Clinical Procedures Manager window. 

 
3. Enter the fields that apply to the instrument you selected.   

 
4. Click Save when you are done. 

 
5. Click Print if you want to print an Automated Instrument report.  See Printing Reports, 

p. 2-4. 
 

 
Figure 6-2 

 
Here is a list of fields for automated instruments. 
 
General:  This section contains general information about the instrument. 
 

Instrument Name:  If you are editing an instrument, the name is filled in.  
 
Note: This field must be filled in for an active instrument to work properly.  
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If you are adding a new instrument that is already supported by CP, do one of the 
following: 

• If the device is bi-directional, you can enter a name of your own choice (3-30 
characters), such as Muse EKG (Tampa). The name does not have to be the 
vendor’s name.  

• If the device is uni-directional, you need to enter a CP defined name. In this 
case, you can contact TSO or NVS for the correct instrument name.  

 
If you are adding a new instrument (bi-directional or uni-directional) that is not supported 
by CP, then you must enter a NOIS/Remedy help ticket. Keep in mind that adding 
unsupported instruments is a complex task and may cause some image quality problems. 
 
Printable Name:  Enter a name for the instrument report (3 to 30 characters). You can 
use the same name as the instrument name. This name is used as the printable name on 
reports. Must be filled in for an active instrument to work properly.  

 
Notification Mailgroup:  Enter the name of a local VistA mailgroup that contains a list 
of people, who will be notified if a problem arises with this automated instrument.   
 
CP also exports a mailgroup called “MD DEVICE ERRORS” that can be used to 
populate this field.   Enter MD and the field fills in with “MD DEVICE ERRORS’. The 
coordinator of this group is assigned during package installation.  Must be filled in for an 
active instrument to work properly.  

 
Description:  Enter a description of the automated instrument (1-50 characters). 
Optional. 

 
Serial Number:  Enter the serial number of the automated instrument (1-50 characters).  
The serial number is used for documentation purposes. Optional. 
 
Active:  Select this option if you want to make the instrument active and able to transmit 
results.   Do not select if the package coordinator wants to prevent data from a specific 
automated instrument from being processed. A package coordinator may want to enter 
the basic information for an automated instrument and not make it active.  Must be 
selected to make this instrument active.  

 
Attachment Processing:  This section contains information about attachments. 
 

Delete when Submitted:  Select this option if the medical center does not want to store a 
duplicate report outside of Imaging, or if the vendor wants to delete files because of 
storage issues.  The vendor determines whether or not the report files can be deleted.  
This information is found in the vendor’s setup instructions.  Optional. 

 
Default Ext.:  Enter a default file extension that is exported by the vendor, such as .html, 
.jpg, and .pdf.  This information should be obtained from the vendor or will be exported 
with future patches. Optional. 
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M Routine:  Indicates the M routine used to process the HL7 message from the 
automated instrument (1-8 characters).  Enter an M routine if the site is entering a new 
device.  The routine must have a namespace of MDHL7* for any nationally released 
interfaces.  This field also is automatically populated when an instrument interface patch 
is installed.  If a local M routine is developed, use the local namespace.  Refer to 
Appendix C – Instrument Processing Routines, p. 17-1, for a list of appropriate M 
routines for each instrument.  Must be filled in for an active instrument to work properly.  

 
Pkg. Code:  Indicates which package is to process the instrument results.  Must be filled 
in for an active instrument to work properly.  

 
Medicine: Select if your study data is stored in the Medicine package.  If a site is 

currently running Medicine and has an instrument used for Medicine, you 
can send the result to Medicine by selecting this field. 

CP V1.0 Select if your study data is stored as a final report (in the format of an 
Imaging document) in Clinical Procedures. 

 
 

Valid Attachment Types:  Data types let CP know what kind of data output to expect 
from the automated instrument so that the data can be processed by the interface routines.  
The vendor setup instructions provide this information, or Clinical Procedures 
automatically exports this information. Must be filled in for an active instrument to work 
properly.  

 
Here is a list of valid attachment types: 
 
UNC (Universal Naming Convention or Uniform Naming Convention) - A PC format for 
specifying the location of resources on a local-area network (LAN). 
 
UUENCODE (Unix-to-Unix ENCODE) - A set of algorithms for converting files into a set 
of ASCII characters that can be transmitted over a network. 
 
Text - Text stored as ASCII codes. 
 
XML (eXtensible Markup Language) - A specification developed by the World Wide Web 
Consortium (W3C), the organization that sets standards for the web.  XML is a pared-down 
version of SGML.  Designed especially for Web documents. 
 
URL (Uniform Resource Locator) - The global address of documents and other resources on 
the World Wide Web. 
 
XMS - An XML Style Sheet. 
 
DLL (Dynamic Link Library) - A library of executable functions or data that can be used by 
a Windows application. 
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Bi-Directional Capabilities:  This section contains specifics on the bi-directional capabilities of 
the instrument. 
 

Bi-Directional Instrument: Select this option if this instrument supports a bi-directional 
interface. 
 
IP Address:  Enter the IP address for the instrument (7-15 characters).  This field is for 
documentation purposes only. Refer to Chapter 11 – Setting Up HL7 Parameters, p. 11-1, for 
more information. Optional. 
 
Port:  Enter the port number for the instrument (a number between 1000 and 99999).  This 
field is for documentation purposes only. Refer to Chapter 11 – Setting Up HL7 Parameters, 
p. 11-1, for more information. Optional. 

 
HL7 Inst ID:  Enter the name of the actual device as provided by the vendor. This field is 
used to ID the device (3-30 characters).  You can contact TSO or NVS for the correct ID. 
Must be filled in for an active instrument to work properly.  
 
HL7 Unv Svc ID:  This field defines what type of procedure the device can perform if the 
device can perform more than one procedure (1-48 characters). Optional. 
 
HL7 Link:  There is one unique link for each instrument.  Select the appropriate link to the 
instrument from the dropdown list. Must be filled in for an active instrument to work 
properly.  
 

Server Executable:  The following fields make up the path for the automated instrument server 
(http://servername/servershare/serverpath/server.exe).  Some devices do not produce reports that 
can be saved. Enter these fields if you want to capture a report from that type of device. 
 

Server Name:  The network name of the automated instrument (1-30 characters).   
Server Share:  The name of the share drive on the automated instrument server (1-30 
characters).   
Server Path:  The full directory path on the automated instrument share (1-150 characters).   
Server Executable:  The name of the executable that produces the report on the automated 
instrument (1-30 characters).  Browse to find the path where the server.exe program resides. 

 

April 2004 Clinical Procedures V. 1.0 6-7 
 Implementation Guide 



Setting Up Clinical Procedures 

 
Adding an Automated Instrument 
 
If a site has an instrument that needs to interface with CP, and that instrument is not exported 
with the Clinical Procedures package, you need to add the instrument. Make sure that CP 
supports the instrument interface. (The Mallinckrodt Clinivision, Olympus Endoworks, GE 
Medical Systems Muse and Viasys/Sensormedics Vmax automated device interfaces are 
exported with Clinical Procedures.) You can also find an updated list of supported devices on the 
CP website at http://vista.med.va.gov/ClinicalSpecialties/clinproc/. 
 
Click Medical Device Interfaces on the left navigation bar, then click About Medical 
Interfaces.  
 
1A warning screen displays when you attempt to add a new instrument (Fig. 6-3). This warning 
screen informs you that you should make sure CP supports the instrument interface you are 
attempting to add.  
 

 
Figure 6-3 

 
If you are adding a new instrument (bi-directional or uni-directional) that is not supported by CP, 
then you can use the New Instrument Request form, which is also located on the CP website at  
http://vista.med.va.gov/ClinicalSpecialties/clinproc/. You can also check p. 17-1 for a list of 
instruments. Keep in mind that adding unsupported instruments is a complex task and may cause 
some image quality problems.  
 
In most cases, you can edit an existing automated instrument instead of adding a new one 
because several automated instruments are installed with Clinical Procedures.  To view the 
names of devices, click the Instruments folder.   A list of automated instruments is displayed on 
the left side of the Clinical Procedures Manager window (Figure 6-4).   
 

                                                 
1 Patch MD*1.0*4  September 2006  Add instrument warning added. 
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Figure 6-4 

 
Indicates active instruments:  
Indicates non-active instruments:  

  
1. Select File > New > Instrument.  The New Instrument screen is displayed. 

 
2. Enter a name that can be used to identify the automated instrument.  If you are adding a 

new instrument that is already supported by CP, do one of the following: 
 

• If the device is bi-directional, you can enter a name of your own choice (3-30 
characters), such as Muse EKG (Tampa).  The name does not have to be the 
vendor’s name.  

• If the device is uni-directional, enter a CP defined name.  In this case, you can 
contact TSO or NVS for the correct instrument name.  

 
If you are adding a new instrument (bi-directional or uni-directional) that is not supported by CP, 
then you must you must enter a NOIS/Remedy help ticket.  Keep in mind that adding 
unsupported instruments is a complex task and may cause some image quality problems. 
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This field must be filled in for an active instrument to work properly. 
 

3. Click OK.  The Edit screen is displayed.  Figure 6-5 is the edit screen for automated 
instruments.  The Automated Instrument Name that you just entered is displayed. 

 
4. Enter data for each field as applicable.  Refer to Editing an Automated Instrument, p. 6-3, 

for detailed field descriptions. 
 

5. Click Save when you are done. 
 

6. Click Print if you want to print an Automated Instrument report.  See Printing Reports, 
p. 2-4. 

 

 
Figure 6-5 
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Using the Instrument Analyzer 
 
Use the Instrument Analyzer to see if an automated instrument is ready to use with CP.   
 

1. Select Tools > Instrument Analyzer. 
2. Select the instrument that you want to analyze.  Click Analyze.  A window similar to 

Figure 6-6 is displayed.  This window indicates the ready status of the instrument and 
lists other information as well. 

 

 
Figure 6-6 

 
• Ready Status - Pass or Fail.  If the Ready Status is Fail, a list of missing fields for that 

automated instrument is displayed. 
• If an Imaging share directory has not been configured, the following message is 

displayed “No Imaging Share indicated in the System Parameters.” 
• If the M Routine (processing routine) is not in the MD or MC namespace, a warning is 

displayed indicating that the M Routine is not in the package namespace. 
 

3. Click Print or Close. 
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Step 3 – Setting Up Procedures 
 
Information on procedures is not complete after populating the CP Definition file.  You must go 
into CP Manager and enter the necessary fields before the package will work successfully. 
 
If the INIT^MDPOST routine was run, a limited number of exported procedures are stored in a 
subfolder called Unassigned within the Procedures folder.  If the INIT^MDPOST routine was 
not run, then you need to add new procedures.  Since all procedures are initially inactive, you 
need to activate existing procedures and associate them with treating specialties. 
 
 
Editing a Procedure 
 
If the procedures have been exported, then you can edit them as needed.  Using CP Manager, 
you must move each procedure that you want to activate from the Unassigned folder to a treating 
specialty folder. 
 

• Double-click the procedure.  Now you can edit the procedure, complete the necessary 
fields, and make the procedure active.   
 

• To activate the procedure, be sure to select the Active field, and then fill in the following 
fields to ensure that the procedure works properly 
 

Treating Specialty 
TIU Note Title 
Hospital Location 

 
To edit a procedure: 
 

1. View the list of procedures. See Fig. 6-7.  
 

2. Click a procedure name.  The edit screen is displayed on the right side of the Clinical 
Procedures Manager window. 
 

3. Enter the fields as applicable.  
 

4. Click Save when you are done. 
 

5. If you selected a different treating specialty folder, a confirmation message is displayed. 
Click OK to confirm that the procedure is in the correct treating specialty folder. 
 

6. Click Print if you want to print a Procedure report.  See Printing Reports, p. 2-4. 
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Note: A procedure can only be deleted through the main menu bar. Refer to the section Deleting 
an Automated Instrument or Procedure, p. 2-3, for more information. If a procedure has been 
assigned through Consults, it cannot be deleted.  
 

 
Figure 6-7 

 
Here is a list of fields for Procedures. 
 
General:  This section contains general information about the procedure. 
 

Procedure Name:  Enter a name used to uniquely identify the procedure (3-30 characters). It 
is recommended that you enter the name in uppercase, such as PACEMAKER FOLLOWUP.  
 
After you complete the edits, if you entered the name in upper case, the procedure name that 
you just entered is displayed in title case, Pacemaker Followup, (the first letter of every word 
is capitalized), in the left side of the CP Manager window. See Figure 6-6.  
 
Active:  Select if you want the procedure to be mapped to Consults.  Only active procedures 
can be selected and linked to the Consults package.  Be sure to fill in the Treating Specialty, 
TIU Note Title, and Hospital Locations fields. Do not select if you do not want procedures to 
display. Must be selected to make this procedure active.  
 
Treating Specialty:  Enter at least two letters of a treating specialty, such as CA for 
CARDIOLOGY, and then click the down arrow to select an appropriate match from the list.  
This list comes from the Treating Specialty (#45.7) file.  Must be filled in for an active 
procedure to work properly.  
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TIU Note Title:  Enter at least two letters of a TIU Note Title, such as CP CARD for CP 
CARDIOLOGY NOTE or CARD for CARDIOLOGY, and then click the down arrow to 
select an appropriate match from the list, which comes from the 8925.1 file. This title must 
be in the CLINICAL PROCEDURES CLASS.   Must be filled in for an active procedure to 
work properly.  

 
1Hospital Location:  Enter at least two letters of a hospital location, such as CA for Cardiac 
Clinic, and then click the down arrow to select an appropriate match from the list, which 
comes from the #44 file. The Hospital Location file is the location where the workload credit 
for the procedure is tracked and is needed so CPRS can display the appropriate encounter 
form when prompted. Must be filled in for an active procedure to work properly.  
 
You can enter a COUNT or NON-COUNT clinic for the hospital location.   
 

 A COUNT clinic captures workload. Patients must be checked in and checked out 
and an encounter form must be completed in order to collect workload. 

 
 A NON-COUNT clinic is used only for scheduling purposes and not for workload 

reporting. 
 
There are three options available for setting up your clinics. The appropriate option for your 
site depends on how you currently do business and should be discussed with your project 
implementation manager. 
 

 COUNT clinic for scheduling purposes / NON-COUNT clinic for CP User. Patient 
must be checked in/out and encounter form completed on the scheduled appointment. 
CP User appointment will not collect workload. 

 
 NON-COUNT clinic for scheduling purposes / COUNT clinic for CP User. 

Appointment in scheduling package does not need to be checked in/out, nor does an 
encounter form need to be completed for the appointment. The check in/out and 
encounter form must be completed for the appointment created through CP User. 

 
 COUNT clinic for scheduling purposes that passes over to CP User. Patient must be 

checked in/out and encounter form must be completed. Note, however, that if you use 
Appointment Manager to check in the patient, you may have to wait up to thirty 
minutes before you can check-in the patient to CP. During the thirty-minute 
timeframe, the Patient Care Encounter (PCE) application establishes the visit date. (If 
you use the Scheduling application to capture workload, make sure that the clinic 
location is the same as the default location in the Hospital Location field.) 

 
Auto Submit to VistA Imaging:  Select if a procedure is processed by a bi-directional 
instrument and additional data does not need to be matched. The study is automatically 

                                                 
1 Patch MD*1.0*4  September 2006  Wording for Count/Non-count clinic modified. 
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submitted to VISTA Imaging. If this field is not selected, the study will be in the Ready to 
Complete status.  Optional.     
 
Require External Data:  Select if you want this procedure to allow external attachments.  
For example, you might want to attach an independent report from a VA or non-VA health 
care facility. If you want to manually select external attachments, you must select this field. 
 
Be sure the Allow Non-Instrument Attachments checkbox is selected in CP Manager > 
System Parameters. There is no default for this field. 
 
External Attachment Directory:  If you select Require External Data, enter the path where 
the data is located, or browse to locate a directory (3-150 characters).  There is no default on 
this field.  You can locate any directory on the LAN. This is the directory that CP User 
accesses to find attachments. This directory must be a network share directory that the VistA 
Imaging Background Processor can access. 

 
Allowable Instruments:  Select each automated instrument that provides results for this 
procedure.  You can select more than one instrument for a procedure. If you only want to use 
external attachments, do not select any instruments.  
 
You can select both Allowable Instruments and Require External Data. For example, you 
can have a pathology report from an endoscopy and you can attach the report to the 
procedure.   
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Adding a Procedure 
  
Before you add a procedure, you can check to see if an appropriated titled procedure already 
exists that meets your needs.  To view the names of procedures, select Procedures and then the 
appropriate treating specialty folder.  A list of procedures is displayed.  See Figure 6-8.  
 

 
Figure 6-8 

 
 - Identifies an active procedure 
 - Identifies a inactive procedure 
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If you decide that you do need to add a procedure, follow these instructions:   
 

1. Select File > New > Procedure.  
 

2. Enter the name of the procedure that you want to add. It is recommended that you enter 
the name in uppercase with a minimum of 3 characters and a maximum of 30 characters. 

 
3. Click OK. The Edit screen is displayed. Figure 6-9 is the edit screen for procedures.  The 

Procedure Name that you just entered is displayed in the left side of the CP Manager 
window in the Unassigned folder.  
 

4. Enter data for each field as applicable.  Refer to Editing a Procedure, p. 6-12, for detailed 
field descriptions.  
 

5. Click Save when you are done.  After you complete the edits, if you entered the name in 
upper case, the procedure name that you just entered is displayed in title case. 
 

6. Click OK.  The new procedure appears in the list on the left side of the CP Manager 
window. Check that the procedure is placed in the correct treating specialty folder.  
 

7. Click Print if you want to print a Procedure report.  See Printing Reports, p. 2-4. 
 

 
Figure 6-9 
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Step 4 – Setting Up System Parameters 
 
System parameters are system-wide and affect all procedures and instruments. You must select 
Clinical Procedure On-Line, and fill in the Imaging Network Share and the VistA Scratch HFS 
Directory fields for CP to work properly.  You can edit the other parameters as required for your 
site.   
 
Here is a list of the system parameters: 
 
*  Indicates fields that must be filled in for CP to work properly. 
 
Allow non-instrument attachments
Bypass CRC Checking
Clinical Procedures Home Page  
*Clinical Procedures On-Line
1* CP/BGP Transfer Directory
CRC Values
Days to keep instrument data
Imaging File Types
Offline Message
Version Compatibility
* VistA Scratch HFS Directory  
 

                                                 
1 Patch MD*1.0*4  September 2006  Imaging Network Share directory name changed to CP/BGP Transfer 
Directory. 
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1. Click System Parameters, which is displayed under the Clinical Procedures 

folder.  The System Parameters Edit window is displayed.  See Figure 6-10.  
 

2. Enter information in the necessary fields and in the optional fields as needed by 
your site. 

 

 
1Figure 6-10 

 
 
Allow non-instrument attachments 
 
Select if you want to let users attach files from the network to studies.  If selected, the +Files 
icon displays in the Study window in CP User and lets the user select attachments. Indicates if 
external attachments (documents) are allowed including when an instrument has not created 
data.   
 

                                                 
1 Patch MD*1.0*4  September 2006  Imaging Network Share directory name changed to CP/BGP Transfer 
Directory. 
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Be sure to select Allow non-instrument attachments if you selected the Require External 
Data field in CP Manager for a specific procedure. If you do not select Allow non-instrument 
attachments, you will not be able to attach files to a procedure.  
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Bypass CRC Checking 
 
Select if you want to bypass CRC (Cyclical Redundancy Check) during startup. When a CP 
application starts up, it can check with the server to be sure that the checksum of the application 
that is running is the same as the checksum of the application that was distributed.  If the 
checksum values do not match, a message displays stating that the values do not match.  Even if 
values don’t match, you can continue using CP.   
 
The checksum value is associated with the version number of the software. You might want to 
bypass this check when your site is running CP in test mode. If you are running different 
versions of the application, then the checksum values will not match.  
 
Clinical Procedures Home Page 
 
Displays the Clinical Procedures home page and directs the browser to this page when accessed.   
This parameter is used by the client application in the Help menu when the user selects the 
option Clinical Procedures on the Web.   
 
Note: The MDPOST routine in the KIDS build sets this field during installation. The data in the 
parameter is predefined. Do not modify this parameter unless the site is performing local 
modifications to the client software. 
 
Clinical Procedures On-Line 
 
Must select if you want to use CP User and CP Gateway.  If this parameter is not selected, a 
warning message is displayed. (If a message has been entered into the Offline Message 
parameter, that message is displayed when the user tries to access CP User.)   
 
This parameter is only effective when the VistA system is functioning and it is useful if you want 
to restrict access to Clinical Procedures. For example, you can set this field to offline if you are 
loading a newer version of CP. 
 
CP/BGP Transfer Directory 
 
Enter the shared directory that is accessed by the Imaging Background  Processor (BGP) and CP 
Gateway.  Reports generated from text need to be placed in a location that can be accessed by 
the BGP.  The Network share must not reside physically on the Imaging RAID.  You can also 
use Browse to select the directory.  Must be filled in for CP to work properly. 
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CRC Values 
 
A site can check that a specific build of the application is running on the client.  This level of 
checking is not mandatory and you can use the Bypass CRC Checking parameter if the site does 
not want this level of security.   
 
If a site is running more than one version of the application or is testing a new patch, this field 
can contain multiple entries, (Fig. 6-11).  Each entry contains the name of the application with 
extension (no directory path) followed by a colon ‘:’ and the executable version number 
‘#.#.#.#’.  Each of these entries contains the CRC value for that particular version of the 
executable.  You can also obtain CRC values for a version of an executable from the About 
menu or by selecting CP Manager > Tools >  Calculate a File’s CRC Value.  
 
Note: The MDPOST routine in the KIDS build sets this field during installation. The data in the 
parameter is predefined. Do not modify this parameter unless the site is performing local 
modifications to the client software 
 

 
1Figure 6-11 

 

                                                 
1 Patch MD*1.0*4  September 2006  Imaging Network Share directory name changed to CP/BGP Transfer 
Directory. 
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Calculating a File’s CRC Value 
 
You can calculate a file’s CRC (Cyclical Redundancy Check) value to determine if the file is the 
exact same file as the one that was distributed.  CRC values are recalculated every time an 
application is compiled.    
 

1. Select Tools > Calculate a file’s CRC Value. 
2. Select the file. 
3. You can copy the CRC value and paste it into a text file for reference purposes.  

 
Days to keep instrument data 
 
Enter the number of days (0-365) to save data from auto-instruments, after the data has been 
associated with a Clinical Procedures study.  If the data has not been associated with a study, the 
data is not purged from the temporary storage area.  Enter 0 or leave the field empty if you want 
the data to be retained forever.   
 
Note:  CP Gateway purges data daily.  This purge only deletes the raw data that comes from the 
instrument.  CP Gateway keeps data for a specified number of days based on the entry in “Days 
to keep Instrument Data”.  Data older than this is purged.  The data in Item Value field (#.1) and 
Item Text field (#.2) of the Upload Item multiple in the CP Results file (#703.1) are purged.   

April 2004 Clinical Procedures V. 1.0 6-23 
 Implementation Guide 



Setting Up Clinical Procedures 

 
Imaging File Types 
 
Verifies that a file type submitted by an instrument or user is acceptable and can be sent to the 
VistA Imaging RAID.  The Open a Study option in CP User uses this system parameter to 
determine if a file is an acceptable file type, (Figure 6-12). 
 
Note: The MDPOST routine in the KIDS build sets this field during installation. The data in the 
parameter is predefined. Do not modify this parameter unless the site is performing local 
modifications to the client software 

 
1Figure 6-12 

                                                 
1 Patch MD*1.0*4  September 2006  Imaging Network Share directory name changed to CP/BGP Transfer 
Directory. 
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Offline Message 
 
Enter a message that users see when they try to activate CP User and Clinical Procedures is 
offline.  This message only displays when the Clinical Procedures On-line parameter is not 
checked. See Figure 6-13. 
 

 
1Figure 6-13 

 
Version Compatibility 
 
Displays a list of client versions, identified by their executable name and windows file version, 
which are compatible with the currently running server version.  More than one version of the 
software may be flagged as compatible for backward compatibility. See Figure 6-14.  
 
To check the client version number: 
 

                                                 
1 Patch MD*1.0*4  September 2006  Imaging Network Share directory name changed to CP/BGP Transfer 
Directory. 

April 2004 Clinical Procedures V. 1.0 6-25 
 Implementation Guide 



Setting Up Clinical Procedures 

1. Open Windows Explorer and locate the Clinical Procedures folder. 
2. Right-click CPGateway.exe, or CPUser.exe., or CPManager.exe. 
3. Select Properties, and then click the Version tab. The version number, such as 1.0.0.17, 

is displayed. 
4. Go back to CP Manager. Double-click Clinical Procedures, and then click System 

Parameters. 
5. In the Version Compatibility tab, select each version that is compatible with the current 

server version, (Figure 6-14). 
 

Note: The MDPOST routine in the KIDS build sets this field during installation. The data in the 
parameter is predefined. Do not modify this parameter unless the site is performing local 
modifications to the client software 
 

 
1Figure 6-14 

 
If an executable version is not compatible, the following message is displayed when you try to 
use a Clinical Procedures application: 

                                                 
1 Patch MD*1.0*4  September 2006  Imaging Network Share directory name changed to CP/BGP Transfer 
Directory. 
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Figure 6-15 

 
If the application is CP Manager, the user is allowed to continue.   If the application is CP User, 
the user needs to contact IRM because the client needs to be upgraded to the current version. 
 
VistA Scratch HFS Directory 
 
Clinical Procedures uses the Host File Server (HFS) functionality in the VA Kernel to create 
reports.  VistA broker processes require full read, write, and delete access to this directory.  
(Check with IRM about this directory.)  If this directory is not filled in, CP tries to use the broker 
environment directory. Must be filled in for CP to work properly. 
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1Step 5 – Exported Kernel XPAR Parameters 
 
There are four Kernel XAR Parameters exported with patch MD*1*14. 

● MD CHECK-IN PROCEDURE LIST 

● MD CLINIC QUICK LIST 

● MD CLINICS WITH MULT PROC 

● MD USE APPT WITH PROCEDURE 

 
A new option called MD AUTO CHECK-IN SETUP was added to setup and implement 
procedures that will use auto study check-in.  Once a procedure is set up to use the auto study 
check-in functionality in the MD CHECK-IN SETUP option, the software will check-in any 
existing order requests with the status of “PENDING,” “ACTIVE,” and “SCHEDULED” in the 
Consult Request Tracking package. 
 
Note: If your site uses appointments, schedule them before you enter the procedures for auto 
check-in.  If you do not, the patients associated with those appointments will need to be 
manually checked in. 
 
This option collects the following information: 
 

1) Use Appointment with procedure? (Yes/No) (Required) – The default is “NO”, if 
the site does not schedule procedures before the order is entered.  Enter “YES” if 
the procedure appointment is scheduled before the order is entered and the 
ordering provider selects the appointment for the procedure during ordering in 
CPRS. 

2) Procedure (Required)– Enter the CP Definition that will be using the auto study 
check-in functionality. 

3) Schedule Appointment? (Required) - Enter 0 for None, 1 for Outpatient, 2 for 
Inpatient, or 3 for Both.  This indicates that the site schedules appointments for 
inpatient, outpatients, both, or none. 

4) Clinic (Optional) – Enter the hospital location(s) that will be used for scheduling 
the procedure. 

 
Note: If no clinic is entered in the setup, CP will use the hospital location defined 
in the HOSPITAL LOCATION field of the CP Definition file (#702.01) as the 
location of the visit for the CP study check-in. 

 
The following two pages contain a screen capture of the MD AUTO CHECK-IN SETUP option: 

                                                 
1 Patch MD*1.0*14  March 2008  Exported Kernel XPAR Parameters, option, and screen sample added. 
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Select OPTION NAME:    MD AUTO CHECK-IN SETUP     Auto Study Check-In Setup 
Auto Study Check-In Setup 
Use Appointment with procedure? NO// ? 
 
Default should be 'N' as most sites do not schedule procedures 
before the order is entered.  Select 'Y' if the procedure appointment 
is scheduled before the order is entered and the ordering provider 
selects the appointment for the procedure. 
Enter either 'Y' or 'N'. 
 
Use Appointment with procedure? NO//  
 
Procedure: ? 
Enter a CP Definition for the procedure to 
have auto CP study check-in. 
 
 Answer with CP DEFINITION NAME 
 Do you want the entire CP DEFINITION List? N  (No) 
 
Procedure: COLONOSCOPY        
Schedule Appointment?: ? 
 
 
REQUIRED field for the procedure to have auto CP study check-in. 
Enter a "^" will exit completely. 
 
Enter 0 if you do not schedule appointments. 
      1 if you only schedule appointments for outpatients. 
      2 if you only schedule appointments for inpatients. 
      3 if you schedule appointments for both 1 and 2. 
 
     Select one of the following: 
 
          0         None 
          1         Outpatient 
          2         Inpatient 
          3         Both 
 
Schedule Appointment?: Both 
Clinic: ?  
Only required, if appointments are scheduled for the procedure. 
Enter the clinic used for scheduling the procedure. 
 
 
 Answer with HOSPITAL LOCATION NAME, or ABBREVIATION, or TEAM 
 Do you want the entire 112-Entry HOSPITAL LOCATION List? N  (No) 
Clinic: GI LAB       PIPER,ALPHA 
 
Enter another clinic for the same procedure? NO// ? 
 
Enter either 'Y' or 'N', if you want to assign more than one clinic. 
 
Enter another clinic for the same procedure? NO//YES 
Clinic: TEST 
     1   TEST/PROSTHETICS       OBRIEN,FRANCES U 
     2   TEST1        
     3   TEST1234        
     4   TEST3232        
CHOOSE 1-4: 2  TEST1      
 
Enter another clinic for the same procedure? NO//  
 
Procedure: ?   
Enter a CP Definition for the procedure to 
have auto CP study check-in. 
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COLONOSCOPY 
 Answer with CP DEFINITION NAME 
 Do you want the entire CP DEFINITION List? N  (No) 
 
Procedure: EKG, ROUTINE (12 LEADS)        
Schedule Appointment?: 0  None 
 
Procedure:  
> 
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7. Scheduled Options 
 
1Two options are added by patch MD*1*14. 
 
 
NAME: MD SCHEDULED STUDIES              MENU TEXT: Scheduled Studies 
  TYPE: run routine                     CREATOR: ACKERMAN,NIEN-CHIN 
  PACKAGE: CLINICAL PROCEDURES 
 DESCRIPTION:   This option is tasked to run daily.  It will process the HL7 
 messages that need to be sent to the device on a daily basis for CP studies.   
  ROUTINE: EN1^MDWORSR                  SCHEDULING RECOMMENDED: YES 
  UPPERCASE MENU TEXT: SCHEDULED STUDIES 
 
 
NAME: MD STUDY CHECK-IN                 MENU TEXT: Study Check-in 
  TYPE: run routine                     CREATOR: ACKERMAN,NIEN-CHIN 
  PACKAGE: CLINICAL PROCEDURES 
 DESCRIPTION:   This option is tasked to run daily.  It checks-in CP studies  
 for procedures that require multiple encounters such as Hemodialysis, 
 Respiratory Therapy, and Sleep Studies.   
  ROUTINE: CLINICPT^MDWORSR             SCHEDULING RECOMMENDED: YES 
  UPPERCASE MENU TEXT: STUDY CHECK-IN 
 
The two options needs to be scheduled to run daily. 
Schedule the option MD SCHEDULED STUDIES to start the next day after patch 
installation at 4am.  This task will process the studies that are associated 
with the appointments that are dated for that day.  If the procedure request 
is associated with a future appointment, the study that is auto checked-in 
will have a status of “New”.  The MD SCHEDULED STUDIES task will process the 
study and change the status to “Pending Instrument Data”. 
 
Sample Screen capture of the scheduled option: 
 
 
Select OPTION to schedule or reschedule: MD     
     1   MD SCHEDULED STUDIES       Scheduled Studies 
     2   MD STUDY CHECK-IN       Study Check-in 
CHOOSE 1-2: 1  MD SCHEDULED STUDIES     Scheduled Studies      (R) 
                          Edit Option Schedule 
    Option Name: MD SCHEDULED STUDIES           
    Menu Text: Scheduled Studies                         TASK ID: 2619819 
  _________________________________________________________________________ 
 
  QUEUED TO RUN AT WHAT TIME: MAY 22,2007@04:00              
 
DEVICE FOR QUEUED JOB OUTPUT: 
 
 QUEUED TO RUN ON VOLUME SET: site volume                   
 
      RESCHEDULING FREQUENCY: 1D                             
 
             TASK PARAMETERS: 
 

                                                 
1 Patch MD*1.0*14  March 2008 Add Scheduled Options. 
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            SPECIAL QUEUEING: 
 
_________________________________________________________________________ 
 
 
 
 
 
COMMAND:                                       Press <PF1>H for help    Insert 
 
 
Schedule the option MD STUDY CHECK-IN to start to run the next day after patch 
installation at 5am.  If a procedure request requires multiple encounters, this task 
will auto check-in the study for the multiple encounters using the appointment 
scheduled.  The RESCHEDULING FREQUENCY can be more than 1D (1 day), if your site 
schedule appointment for the day after 5am and the task will not be able to pick it 
up. 
 
 
Select OPTION to schedule or reschedule: MD STUDY CHECK-IN       Study Check-in 
         ...OK? Yes//   (Yes) 
      (R) 
                          Edit Option Schedule 
    Option Name: MD STUDY CHECK-IN              
    Menu Text: Study Check-in                            TASK ID: 2620037 
  __________________________________________________________________________ 
 
  QUEUED TO RUN AT WHAT TIME: MAY 22,2007@05:00              
 
DEVICE FOR QUEUED JOB OUTPUT: 
 
 QUEUED TO RUN ON VOLUME SET: site volume                   
 
      RESCHEDULING FREQUENCY: 1D                             
 
             TASK PARAMETERS: 
 
            SPECIAL QUEUEING: 
 
_________________________________________________________________________ 
 
 
 
 
 
COMMAND:                                       Press <PF1>H for help    Insert 
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8. Setting Up Consults for Clinical Procedures 
 
This section explains how to set up services and procedures in the Consults package.  Be sure the 
GMRC*3*17 patch is present before you implement Consults.    
 
Topics discussed in this chapter are: 
 

• Step 1 – Setting Up Consult Services 
• Step 2 – Creating Consult Procedures 

 
 
Step 1 – Setting Up Consult Services 
 
Consult services must be set up so that users can receive alerts about procedure status and be 
able to process the procedure.  You need to determine if a consult service exists that can be used 
only for CP procedures or if you need to create new consult services.  A CP consult service is a 
subspecialty service that deals specifically with CP procedures.  Be sure to use the CP prefix 
when you add a service.  
 
Create a New Consult Service/Define an Interpreter: 
 
You use the Consult Management menu to create a new consult service, to define an interpreter, 
and add that new consult service under the All Services specialty/subspecialty.  A new consult 
service has to be added to the “All Services” specialty/subspecialty before the CP procedures 
will appear on the Consults tab in CPRS. 
 
   RPT    Consult Tracking Reports ... 
   SS     Set up Consult Services 
   SU     Service User Management 
   CS     Consult Service Tracking 
   RX     Pharmacy TPN Consults 
   GU     Group update of consult/procedure requests 
   UA     Determine users' update authority 
   UN     Determine if user is notification recipient 
   NR     Determine notification recipients for a service 
   TD     Test Default Reason for Request 
   LH     List Consult Service Hierarchy 
   PR     Setup procedures 
   CP     Copy Prosthetics services 
   DS     Duplicate Sub-Service 
   IFC    IFC Management Menu ... 
   TP     Print Test Page 
 
****** Select Consult Management Option: SS  Set up Consult Services 
Select Service/Specialty:CP CARDIOLOGY 
  Are you adding 'CP CARDIOLOGY' as a new REQUEST SERVICES (the 123RD)? No// Y  
(Yes) 
  
SERVICE NAME: CP CARDIOLOGY// <RET> 
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ABBREVIATED PRINT NAME (Optional): CARDIOL 
INTERNAL NAME: <RET> 
Select SYNONYM: <RET> 
SERVICE USAGE: <RET> 
SERVICE PRINTER: <RET> 
NOTIFY SERVICE ON D <RET> C: 
REPRINT 513 ON DC: <RET> 
PREREQUISITE: 
  No existing text 
  Edit? NO// <RET> 
PROVISIONAL DX PROMPT: <RET> 
PROVISIONAL DX INPUT: <RET> 
DEFAULT REASON FOR REQUEST: <RET> 
  No existing text 
  Edit? NO// <RET> 
RESTRICT DEFAULT REASON EDIT: <RET> 
  
Inter-facility information 
IFC ROUTING SITE: <RET> 
IFC REMOTE NAME: <RET> 
Select IFC SENDING FACILITY: <RET> 
  
To define an interpreter, you can enter a user name in one of the following fields.   
 
Note: Users entered into Update Users W/O Notifications or Update Teams W/O Notifications 
will not receive alerts. 
 
- INDIVIDUAL TO NOTIFY 
- SERVICE TEAM TO NOTIFY 
- NOTIFICATION BY PT LOCATION 
- UPDATE USERS W/O NOTIFICATIONS 
- UPDATE TEAMS W/O NOTIFICATIONS 
 
 
SERVICE INDIVIDUAL TO NOTIFY: CPPROVIDER, ONE 
Select SERVICE TEAM TO NOTIFY: CONSULT TEAM 
Select NOTIFICATION BY PT LOCATION: <RET> 
PROCESS PARENTS FOR NOTIFS: <RET> 
Select UPDATE USERS W/O NOTIFICATIONS: CPUSER, THREE 
Select UPDATE TEAMS W/O NOTIFICATIONS: <RET> 
Select UPDATE USER CLASS W/O NOTIFS <RET> : 
Select ADMINISTRATIVE UPDATE USER: <RET> 
Select ADMINISTRATIVE UPDATE TEAM: <RET> 
PROCESS PARENTS FOR UPDATES: <RET> 
 
SPECIAL UPDATES INDIVIDUAL: <RET> 
RESULT MGMT USER CLASS: <RET> 
UNRESTRICTED ACCESS: <RET> 
Select SUB-SERVICE/SPECIALTY: <RET> 
 
Add/Edit Another Service? NO// <RET> 
 
Now the service you just created must be added to the All Services service/specialty. 
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Select Consult Management Option: SS  Set up Consult Services 
Select Service/Specialty:ALL SERVICES       GROUPER ONLY 
SERVICE NAME: ALL SERVICES// <RET> 
ABBREVIATED PRINT NAME (Optional): ALL// <RET> 
Select SYNONYM: <RET> 
SERVICE USAGE: GROUPER ONLY// <RET> 
SERVICE PRINTER: <RET> 
NOTIFY SERVICE ON DC: <RET> 
REPRINT 513 ON DC: <RET> 
PREREQUISITE: 
  No existing text 
  Edit? NO// <RET> 
PROVISIONAL DX PROMPT: <RET> 
PROVISIONAL DX INPUT: <RET> 
DEFAULT REASON FOR REQUEST: 
  No existing text 
  Edit? NO// <RET> 
RESTRICT DEFAULT REASON EDIT: <RET> 
  
SERVICE INDIVIDUAL TO NOTIFY: CPPROVIDER, ONE 
Select SERVICE TEAM TO NOTIFY: CONSULT TEAM 
Select NOTIFICATION BY PT LOCATION: <RET> 
PROCESS PARENTS FOR NOTIFS: <RET> 
Select UPDATE USERS W/O NOTIFICATIONS: CPUSER, THREE 
Select UPDATE TEAMS W/O NOTIFICATIONS: <RET> 
Select UPDATE USER CLASS W/O NOTIFS: <RET> 
Select ADMINISTRATIVE UPDATE USER: <RET> 
Select ADMINISTRATIVE UPDATE TEAM: <RET> 
PROCESS PARENTS FOR UPDATES: <RET> 
  
SPECIAL UPDATES INDIVIDUAL: <RET> 
RESULT MGMT USER CLASS: <RET> 
UNRESTRICTED ACCESS: <RET> 
Select SUB-SERVICE/SPECIALTY: CP CARDIOLOGY        
  Are you adding 'CP CARDIOLOGY' as a new SUB-SERVICE (the 13TH for this 
REQUEST SERVICES)? No// Y 
  (Yes) 
  MNEMONIC:  
Select SUB-SERVICE/SPECIALTY: <RET> 
 
Add/Edit Another Service? NO//<RET> 
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Editing Users of an Existing Consult Service: 
 
You can also use the Service User Management option to edit a Consult Service’s Update Users 
fields. 
 
   RPT    Consult Tracking Reports ... 
   SS     Set up Consult Services 
   SU     Service User Management 
   CS     Consult Service Tracking 
   RX     Pharmacy TPN Consults 
   GU     Group update of consult/procedure requests 
   UA     Determine users' update authority 
   UN     Determine if user is notification recipient 
   NR     Determine notification recipients for a service 
   TD     Test Default Reason for Request 
   LH     List Consult Service Hierarchy 
   PR     Setup procedures 
   CP     Copy Prosthetics services 
   DS     Duplicate Sub-Service 
   IFC    IFC Management Menu ... 
   TP     Print Test Page 
 
 
 
Select Consult Management Option: SU  Service User Management 
 
Select Service/Specialty: cp cardiology        
 
Make sure data is entered for the applicable fields listed below: 
SERVICE INDIVIDUAL TO NOTIFY: CPPROVIDER, ONE 
Select SERVICE TEAM TO NOTIFY: CONSULT TEAM 
Select NOTIFICATION BY PT LOCATION: <RET> 
Select UPDATE USERS W/O NOTIFICATIONS: CPUSER, THREE 
Select UPDATE TEAMS W/O NOTIFICATIONS: <RET> 
Select UPDATE USER CLASS W/O NOTIFS: <RET> 
Select ADMINISTRATIVE UPDATE USER: <RET> 
Select ADMINISTRATIVE UPDATE TEAM: <RET> 
SPECIAL UPDATES INDIVIDUAL: <RET> 
 
Select Service/Specialty: <RET> 
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Step 2 - Creating Consult Procedures 
 
Consult procedures in the GMRC file (#123.3) must be linked to clinical procedures.  Be sure to 
use the “CP” prefix when you create new consult procedures to differentiate them from other 
consult procedures.  
 
The following example shows how to create the consult procedure CP EKG 12 LEAD STAT and 
link it to the clinical procedure definition EKG, ROUTINE (12 LEADS). 
 
1Note: Add the text “Visit Date: |VISIT DATE|“ to the first line of the DEAFULT REASON 
FOR REQUEST field.  This will allow CP to pick up the appointment date/time from CPRS for 
the order request and use it for the auto CP study check-in.   If you do not use appointments at 
all, you can skip the adding of the text.  If your site schedules appointments, but the ordering 
provider does not select the appointment during ordering, you can still add the text. If there is 
already text in the DEFAULT REASON FOR REQUEST field, add the visit date text to the very 
first line. 
 
Select Consult Ma g O PR   Setup procedures na ement ption:  
Select Procedure:CP EKG 12 LEAD STAT 
NAME:  CP EKG 12 LEAD STAT//  <RET> 
INACTIVE: NO// <RET> 
Select SYNONYM: EKG// <RET> 
INTERNAL NAME: <RET> 
Select RELATED SERVICES: CP CARDIOLOGY// <RET> 
TYPE OF PROCEDURE: ECG// <RET> 
CLINICAL PROCEDURE: EKG, ROUTINE (12 LEADS)// <RET> 
 
PREREQUISITE: 
  No existing text 
  Edit? NO// <RET> 
PROVISIONAL DX PROMPT: REQUIRED// <RET> 
PROVISIONAL DX INPUT: LEXICON// <RET> 
DEFAULT REASON FOR REQUEST: 
1>Visit Date: |VISIT DATE| 
2>Patient’s heart is beating abnormally.  Needs analysis. 
  Edit? NO// <RET> 
RESTRICT DEFAULT REASON EDIT: NO EDITING// <RET> 
 
Orderable Item Updated 
 
Field Descriptions: 
 
NAME: The name of the procedure as it appears in the GMRC Procedure file (#123.3). 
 
INACTIVE: Indicates if a procedure is no longer in use. 
 
SYNONYM: Enter other names commonly used to refer to this procedure. 

                                                 
1 Patch MD*1.0*14  March 2008  Added visit date setup for auto study check in. 
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INTERNAL NAME: Enter a name for the procedure that is used internally by the facility. 
 
RELATED SERVICES: Indicates which Consult services from the Request Services (#123.5) 
file are responsible for processing requests for this procedure. 
 
TYPE OF PROCEDURE:  Not applicable. 
 
CLINICAL PROCEDURE:  Provides a mapping between the CP Definitions (#702.01) file 
and the GMRC Procedures file.  (CP definition entries must be active before you can map them.) 
Orders placed for a procedure having a valid entry in this field are processed and resulted using 
the Clinical Procedures package.   
 
PREREQUISITE: Enter information on any consults or procedures that must be performed 
prior to ordering this consult.  This field is presented to the ordering person upon selecting a 
Consult service and lets the ordering person abort the ordering if necessary.  TIU objects may be 
embedded within this field, which are resolved for the current patient during ordering.  Any TIU 
objects must be contained within vertical bars, such as |BLOOD PRESSURE|. 
  
PROVISIONAL DX PROMPT: Used by CPRS to determine how to prompt for the provisional 
diagnosis when ordering this procedure.  Set to OPTIONAL if you want the user to be prompted 
for the provisional diagnosis but also can let the user bypass answering the prompt.  Set to 
SUPPRESS if you do not want the user to be presented with the provisional diagnosis prompt.  
Set to REQUIRED if you want to enforce the user to answer the prompt before continuing to 
place the order.  
 
PROVISIONAL DX INPUT: Determines the method that CPRS uses to prompt the user for 
input of the provisional diagnosis when ordering this procedure.  Set to FREE TEXT and the 
user may type any text from 2-80 characters in length.  Set to LEXICON and the user is required 
to select a coded diagnosis from the Clinical Lexicon.  
 
DEFAULT REASON FOR REQUEST: Enter default text that can be used as the reason for 
request when ordering this procedure.  This field allows boilerplate text to be imported into the 
reason for request.  If the user places an order using a quick order having boilerplate text, that 
text supersedes any default text stored in this field.  This field may contain any text including 
TIU objects.  TIU Objects must be enclosed in vertical bars, such as |PATIENT NAME|.  
 
RESTRICT DEFAULT REASON EDIT: Set to UNRESTRICTED, NO EDITING, or ASK 
ON EDIT ONLY.  If ASK ON EDIT ONLY is used, the user can only edit the default reason if 
the order is edited before releasing to the service.  If a default reason for request exists, the 
option set in this field affects the ordering person’s ability to edit the default reason.  
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9. Setting Up CPRS for Clinical Procedures 
 
This section explains how to set up notifications and parameters in the CPRS package.   
Topics discussed in this chapter are: 
 

• Step 1 – Setting Up the Notification - Recommended 
• Step 2 – Editing Parameters – Some parameters must be defined. See Step 2 – Editing 

Parameters, p. 9-3. 
 
 
Step 1 – Setting Up the Notification 
 
You must enable the CONSULT/PROC INTERPRETATION notification if you want to receive 
the “Ready for interpretation” alert in CPRS.  You can enable the alert for one user, several 
users, or for the entire service.  Use the Notification Mgmt Menu [ORB NOT COORD MENU]. 
 
   1      Enable/Disable Notifications  
   2      Erase Notifications 
   3      Set Urgency for Notifications (GUI) 
   4      Set Deletion Parameters for Notifications 
   5      Set Default Recipient(s) for Notifications 
   6      Set Default Recipient Device(s) for Notifications 
   7      Set Provider Recipients for Notifications 
   8      Flag Orderable Item(s) to Send Notifications 
   9      Archive(delete) after <x> Days 
   10     Forward Notifications ... 
   11     Set Delays for Unverified Orders ... 
   12     Set Notification Display Sort Method (GUI) 
   13     Send Flagged Orders Bulletin 
   14     Determine Recipients for a Notification 
   15     Display Patient Alerts and Alert Recipients 
   16     Enable or Disable Notification System 
   17     Display the Notifications a User Can Receive 
 
Select Notification Mgmt Menu Option: 1 Enable/Disable Notifications  
 
 
               Set PROCESSING FLAG Parameters for Notifications 
 
Processing Flag may be set for the following: 
 
     1   User          USR    [choose from NEW PERSON] 
     2   Team (OE/RR)  OTL    [choose from OE/RR LIST] 
     3   Service       SRV    [choose from SERVICE/SECTION] 
     4   Location      LOC    [choose from HOSPITAL LOCATION] 
     5   Division      DIV    [HINES DEV. EVALUATION] 
     6   System        SYS    [EVL.DEV.ISC-CHICAGO.VA.GOV] 
     7   Package       PKG    [ORDER ENTRY/RESULTS REPORTING] 
 
Enter selection: Set this parameter according to the individual preference of your site. 
 
------------- Setting Processing Flag ------------- 
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Select Notification: ? 
 
There are currently no entries for Notification. 
 
 Answer with OE/RR NOTIFICATIONS NUMBER, or NAME, or PACKAGE ID, or 
     MESSAGE TEXT 
 Do you want the entire 49-Entry OE/RR NOTIFICATIONS List? N  (No) 
     
Select Notification: CONSULT/PROC INTERPRETATION 
Are you adding CONSULT/PROC INTERPRETATION as a new Notification? Yes// <RET>  
YES 
 
Notification: CONSULT/PROC INTERPRETATION// <RET>  CONSULT/PROC INTERPRETATION   
CONSULT/PROC INTERPRETATION 
Value: ? 
 
Code indicating processing flag for the entity and notification. 
 
     Select one of the following: 
 
          M         Mandatory 
          E         Enabled 
          D         Disabled 
 
Value: Enabled 
 

• Select Mandatory to specify that the notification cannot be turned off by the user. 
• Select Enabled to specify that the user can turn off the notifications. 
• Select Disabled to specify that notifications are not used. 

 
After you set up the notification, you can set up quick orders and place them on appropriate 
order menus.  Refer to the CPRS Setup Guide, which can be found in the VistA Documentation 
Library (VDL). 
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Step 2 – Editing Parameters 
 
You can edit the following parameters in CPRS to indicate who should enter Patient Care 
Encounter information and how Windows messages are sent. You can also add CP User to the 
CPRS Tools menu.  
 
Use the CPRS Manager menu to set these parameters: 
 

• Ask Encounter Update (ORWPCE ASK ENCOUNTER UPDATE) Required. 
• Broadcast Messages to Other Apps (ORWOR BROADCAST MESSAGES) Required. 
• Force PCE Entry (ORWPCE FORCE PCE ENTRY) Required. 
• Add CP User to the CPRS Tools Menu Optional. 
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Ask Encounter Update (ORWPCE ASK ENCOUNTER UPDATE) 
 
The ORWPCE ASK ENCOUNTER UPDATE parameter determines if the user should be 
prompted to enter encounter information when signing a note.  The Encounter Form in the AICS 
package is used to collect workload data.  If a specific Encounter Form is not set up and linked to 
a hospital location, a generic Encounter Form is presented. Each service that has a study 
associated with it must set this parameter to Always. 
 
Select OPTION NAME: CPRS MANAGER MENU  ORMGR     CPRS Manager Menu 
 
   CL     Clinician Menu ... 
   NM     Nurse Menu ... 
   WC     Ward Clerk Menu ... 
   PE     CPRS Configuration (Clin Coord) ... 
   IR     CPRS Configuration (IRM) ... 
 
Select CPRS Manager Menu Option: IR  CPRS Configuration (IRM) 
 
   OC     Order Check Expert System Main Menu ... 
   TI     ORMTIME Main Menu ... 
   UT     CPRS Clean-up Utilities ... 
   XX     General Parameter Tools ... 
 
Select CPRS Configuration (IRM) Option: XX  General Parameter Tools 
 
   LV     List Values for a Selected Parameter 
   LE     List Values for a Selected Entity 
   LP     List Values for a Selected Package 
   LT     List Values for a Selected Template 
   EP     Edit Parameter Values 
   ET     Edit Parameter Values with Template 
   EK     Edit Parameter Definition Keyword 
 
Select General Parameter Tools Option: EP  Edit Parameter Values 
                         --- Edit Parameter Values ---  
 
SELECT PARAMETER DEFINITION NAME: ORWPCE ASK ENCOUNTER UPDATE     Ask 
Encounter Update 
 
ORWPCE ASK ENCOUNTER UPDATE may be set for the following: 
 
     1   User          USR    [choose from NEW PERSON] 
     2   Location      LOC    [choose from HOSPITAL LOCATION] 
     3   Service       SRV    [choose from SERVICE/SECTION] 
     4   Division      DIV    [HINES DEVELOPMENT] 
     5   System        SYS    [DEV.DEV.FO-HINES.MED.VA.GOV] 
     6   Package       PKG    [ORDER ENTRY/RESULTS REPORTING] 
 
Enter selection: Set this parameter according to the individual preference of your site. 
 
-------- Setting ORWPCE ASK ENCOUNTER UPDATE -------- 
ASK ENCOUNTER UDPATE: ALWAYS 
 
If the site wants credit for workload for the inpatient and outpatient, select Always at this 
prompt. 
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Broadcast Messages to Other Apps (ORWOR BROADCAST MESSAGES) 
 
The ORWOR BROADCAST MESSAGES parameter tells CPRS to send a message to all VistA 
applications stating that a new patient record is open or a new TIU note has been selected. This 
parameter setting allows all applications on the desktop, such as CP User, and VistA Imaging, to 
synchronize with CPRS.  Always set this parameter to System. 
 
Select PARAMETER DEFINITION NAME: ORWOR BROADCAST MESSAGES     Broadcast 
Window Messages to Other Apps 
 
ORWOR BROADCAST MESSAGES may be set for the following: 
 
     1   User          USR    [choose from NEW PERSON] 
     5   System        SYS    [DEV.DEV.FO-HINES.MED.VA.GOV] 
     10  Package       PKG    [ORDER ENTRY/RESULTS REPORTING] 
 
Enter selection: 5  System   DEV.DEV.FO-HINES.MED.VA.GOV 
 
- Setting ORWOR BROADCAST MESSAGES  for System: DEV.DEV.FO-HINES.MED.VA.GOV - 
Enable Broadcasting Windows Messages: YES// <RET> 
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Force PCE Entry (ORWPCE FORCE PCE ENTRY) 
 
If encounter data is missing, the user should be asked to enter the missing data.  You must select 
Yes to the Force GUI PCE ENTRY prompt. 
 
Select PARAMETER DEFINITION NAME: ORWPCE FORCE PCE ENTRY     Force PCE Entry 
 
ORWPCE FORCE PCE ENTRY may be set for the following: 
 
     1   User          USR    [choose from NEW PERSON] 
     2   Location      LOC    [choose from HOSPITAL LOCATION] 
     3   Service       SRV    [choose from SERVICE/SECTION] 
     4   Division      DIV    [HINES DEVELOPMENT] 
     5   System        SYS    [DEV.DEV.FO-HINES.MED.VA.GOV] 
     6   Package       PKG    [ORDER ENTRY/RESULTS REPORTING] 
 
Enter selection: Set this parameter according to the individual preference of your site. 
 
---------- Setting ORWPCE FORCE PCE ENTRY ---------- 
FORCE GUI PCE ENTRY: ? 
 
Do you wish to force entry of PCE data in the CPRS GUI?. 
 
     Select one of the following: 
 
          0         NO 
          1         YES 
 
FORCE GUI PCE ENTRY: 1  YES 
 
When data is needed and the user is the primary encounter provider, the ORWPCE FORCE PCE 
ENTRY parameter is checked to determine if the user needs to enter the missing encounter 
information before being allowed to sign the note.  When this parameter is set to YES, users are 
asked to enter the missing data.  When this parameter is set to NO, users are asked if they want 
to enter encounter information.   
 
When data is needed and the user is the primary encounter provider, continued checks are made 
during the note-signing process to determine if there is still missing data.  The user is continually 
prompted to enter the data, regardless of the ORWPCE FORCE PCE ENTRY setting. 
 
If data is not needed or if the user is not the primary encounter provider, “Yes” and “No” 
prompts are displayed and the user determines what to enter.   
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Add CP User to the CPRS Tools Menu (ORWT TOOLS MENU) 
 
You can use the ORWT TOOLS MENU to set up access to CP User from the CPRS Tools menu. 
You can set up the options for the site and then override them as appropriate at the division, 
service, and user levels. Here are some guidelines: 
 

• Enter each item in the format, NAME=COMMAND.   
 
NAME is the name that displays on the menu, such as CP User.  If you want to provide 
keyboard access, you can also enter & in front of a letter, such as CP &User.    
 
COMMAND is the directory path followed by the executable name.   

 
Notes: 
 

• You must surround a path that contains space characters, such as C:\Program Files\... 
with quotation marks.  You can also include switches in the path.  Here’s an example: 

 
CP User=”C:\Program Files\Clinical Procedures\CP User.exe” /cprs 
/dfn=%DFN /s=%SRV /p=%PORT 

 
• You can pass context-sensitive parameters, which are entered as placeholders, and then 

converted to the appropriate values at runtime.  The placeholder parameter used with 
Clinical Procedures is: 

 
%DFN Indicates the DFN of the currently selected patient in CPRS.  This parameter 

passes the current patient to Clinical Procedures. You can also use %DFN as a 
placeholder in other CP applications. 
 

%SRV Indicates the name of the server that CPRS is currently connected to.  This 
parameter passes the current server name to Clinical Procedures. You can also 
use %SRV as a placeholder in other CP applications. 

 
%PORT Indicates the listener port that CPRS is currently communicating through.  

This parameter passes the current listener port to Clinical Procedures. You can 
also use  %PORT as a placeholder in other CP applications. 

 
• Command line switches, such as nonsharedbroker, can be used.  Refer to Appendix A - 

CP Application Startup Options and Command Line Switches, p. 15-1 for more 
information. 

 
 
Example: Create a tools menu option that contains CP User. 
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From the system prompt, do the following: 
 
 
 
Select PARAMETER DEFINITION NAME: orwt TOOLS MENU     CPRS GUI Tools Menu ORWT TOOLS MENU may 
be set for the following: 
     1   User          USR    [choose from NEW PERSON] 
     2   Location      LOC    [choose from HOSPITAL LOCATION] 
     2.5 Service       SRV    [choose from SERVICE/SECTION] 
     3   Division      DIV    [REGION 5] 
     4   System        SYS    [OEC.ISC-SLC.VA.GOV] 
Enter selection: 1  User   NEW PERSON 
Select NEW PERSON NAME: CPUSER, FOUR          CF 
  
-------------- Setting ORWT TOOLS MENU  for User: DELAWARE,JOHN -------------- 
Select Sequence: 1 
Are you adding 1 as a new Sequence? Yes//   YES 
Sequence: 1//    1 
Name=Command: CP User=”<directory name>\CP User.exe” /cprs /dfn=%DFN /s=%SRV /p=%PORT 
Select Sequence: 

Fig. 9-1 

 
When you select “CP User” from the CPRS Tools menu, CP User is displayed and the actual 
server, port, and global reference are substituted for the command line switches. 
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10. Working with CP Gateway 
 
CP provides bi-directional capabilities for the HL7 interface.  With this feature, the VistA system 
can send information about a patient procedure directly to the instrument, which eliminates 
duplicate entries of patient data into an instrument.  CP Gateway sends the results to the VistA M 
environment and converts the data into a usable format for the CP and VistA Imaging 
applications.  
 
Every night after midnight, CP Gateway purges data based on the value in the Days to keep 
Instrument Data field (See CP Manager > System Parameters).  This purge only deletes the 
raw data that comes from the instrument.  The data to be purged has already been matched to a 
study.   
 
The following flowchart describes what the CP Gateway does. 
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Starting the CP Gateway application is the same as starting any VistA Broker application, which 
requires a VistA application and the appropriate command line switches.  Refer to Appendix A - 
CP Application Startup Options and Command Line Switches for more information.  1The CP 
Gateway application can be run on a server or on a workstation.  The application must be 
launched by a person with VistA Access and Verify codes.  This person must be assigned the 
MD GUI MANAGER menu option to be able to access the CP Gateway.  DO NOT run the CP 
Gateway on a workstation that is running VistA Imaging. 
 
Note: Remember to re-start the CP Gateway, if the workstation is re-started for some reason 
such as upgrade and patches.  This will keep the connection up for the device interface and CP. 
 
Note 2: It is not necessary but if you want to configure a stand alone server or workstation for the CP 
Gateway, use the VA Naming Conventions.  Your domain will be VHAxxx where xxx is the site's 3-
character assigned name (e.g.,VHAISH is the domain name at Hines Field Office).  You could use 
the following server name:  VHA + 3-letter site name + CPG  i.e., VHAISHCPG  
 
After the application starts, three checks are performed to ensure that the proper environment 
exists. 

• Verifies that the CP Gateway is a compatible version with the server installation. 
• Verifies that the CP Gateway is the only one running in the selected environment (such 

as UCI and Volume set). 
• Verifies that the CP Gateway has Read Write and Delete access to the directory stored in 

the MD IMAGING XFER DIRECTORY parameter. 
 
If any of these checks fail, the processor shuts down.  If the checks are acceptable, the 
application displays on the workstation as shown, Figure 10-1. 
 

 
Figure 10-1 

 
Click Show Log to view the application log.  A session log is kept for the currently running 
session but is not saved to the workstation’s hard drive for patient security reasons.  
 

                                                 
1 Patch MD*1.0*14  March 2008  Added information about launching the CP Gateway. 
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Figure 10-2 

 
The log file tracks all the background operations and any problems that occur during the 
processing of attachments, Figure 10-2.  In addition, the log file lists the date/time stamp of the 
background operation, a description of the background operation, and the number of studies to 
process at that time.   
 
 
Log File Options 
 
The following options are available while viewing the log file. 
 

• Click Find to rapidly search the log file.  A standard Windows find dialog is displayed 
and you can search the entire log file for a text value. 

 
• Click Save if you want to save the entire contents of the log to an external file.  The log 

file is saved in Rich Text Format (RTF) and can easily be opened in MS Word or other 
word processing applications. 
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• Click Clear to clear all entries in the current sessions log file.  Be careful since you 
cannot recover past log entries if you have not previously saved them to a file. 
 

• Click Print to select a printer and print the log. Be careful to check the size of the log file 
as it may be large if you have not cleared it recently. 

 
You can display information about the server and you can also manage how the Gateway works. 

 
• Choose File > Status.  The server settings are displayed, Figure 10-3. 

 

 
Figure 10-3 

 
• Choose File > Shutdown.  The server process is stopped and the application is 

terminated.  
 

• Choose File > Set Poll Interval, Figure 10-4.  The CP Gateway polls for new instrument 
data to transmit to VistA.  You can adjust the number of seconds between polling 
operations.  Enter a value from 10 to 300 seconds.  The new value becomes effective 
after the next polling operation so it may take up to 5 minutes for the new value to be 
used.   

 

 
Figure 10-4 
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• Choose File > Set Maximum Log Entries.  You can adjust the number of entries that 

are stored in the log file.  Enter a value from 100 to 10000.  After this value is reached, 
entries are deleted from the beginning of the log to keep the log file from growing too 
large.  The new value becomes effective after the next polling operation so it may take up 
to 5 minutes for the new value to be used.  When the CP Gateway is shut down, all 
entries are deleted from the log file. 

 
 

10-6 Clinical Procedures V. 1.0 April 2004 
 Implementation Guide 



 

11. Setting Up HL7 Parameters 
 
1This section describes how to set up the HL7 parameters including configuration instructions, 
file settings, and technical issues.  The tasks in this chapter require a working knowledge of the 
VistA HL7 application. 
 
Topics discussed in this chapter are: 
 

• Configuration Instructions Information 
o IP Addresses and Ports 

• Setting Up a New HL7 Single Listener for High-Volume Devices 
o Creating a Logical Link 
o Creating a Device Protocol Client 
o Activating the Logical Links 
o Adding a Device Client as a Server Subscriber 

• Using Port 5000 
o Benefits of Using a Single Port Listener 
o Setting Up Port 5000 

• File Settings 
• Technical Issues 

 
Configuration Instructions Information 

 
You can follow the steps described in this section to configure the HL7 application.  
 
MCAR INST and MCAR OUT are automatically created during the KIDS installation. MCAR 
INST is used for all devices that send results information from the device to VistA and CP. Since 
all devices can use the same link, you only need one entry in the HL Logical Link (870) file.  
 
However, you need to establish an MCAR OUT entry for each bi-directional device that receives 
information from VistA and CP. Each entry needs its own IP and port number, which agree with 
the device configuration. (Use the MCAR OUT sample provided in the HL Logical Link file. Set 
up the individual links for each bi-directional device. ) 
 
IP Addresses and Ports 
 
You need to set up IP addresses and ports for the medical devices at your facility.  
 
An IP address consists of a string of four numbers each ranging in value from 0 to 255.  Here is 
an example of an IP address: 10.23.55.201.  When a new device is installed, be careful when you 
assign IP addresses to the medical devices.  It’s recommended that you set aside a block of IP 
addresses specifically for the medical devices.  The range of numbers chosen is up to the facility, 
but make sure that there is a large enough range to allow for some growth.  For example, IP 
                                                 
1 Patch MD*1.0*14  March 2008  Chapter revised to provide clarity. 
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addresses 10.23.55.201 through 10.23.55.225 could be blocked and used.  In this way, the IRM 
staff can track down any possible problems that may be related to the medical device by looking 
at the IP address. 
 
A port is the location on a medical device where you send and receive data.  Some ports have 
predefined functions.  For example, Port 80 is set up for the Web Server. Some vendors have 
predefined ports that they may want you to use.  For example, Sensormedics recommends using 
Port 20000 for the VMAX.  Others may only allow a limited range.  Consult the device manual 
to determine which ports you can use. 
 
A Startup Node defines the system on which you want the link to start. 
 
Setting Up a New HL7 Single Listener for High-Volume Devices 
Most medical devices send results to VistA using nonpersistent connections to the same port. 
Each device connects to the port just long enough to send results to VistA, then releases the port 
so that other devices may connect to it.  
 
However, if you use a high-volume device (i.e., something that sends about 200 or more 
messages back and forth per day, such as MUSE or a hemodialysis device) that sends a lot of 
data all the time, we recommend that you give it its own port instead of sharing a port with other 
devices. This is because high-volume devices send so much data that they can tie up the port for 
a long time, preventing other devices (e.g., Olympus or Sensormedics) from using it.  
 
Setting up a new HL7 listener involves four steps (which are described in more detail below): 
 

1. Creating a Logical Link 
2. Creating a Device Protocol Client 
3. Activating the Logical Links 
4. Adding a Device Client as a Server Subscriber 

 
This document also contains information on Using Port 5000 what it is and when to use it). 
 
Note: Although you can name your new logical links and device protocols anything you want, 
keep the names name spaced and descriptive since the names are similar and it can be easy to 
confuse them. 
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Creating a Logical Link 
A logical link is an inbound or an outbound instrument data port from and to the medical device. 
It’s a listener waiting for data to come across. The first logical link (MCAR INST) is already 
created by default. To create a new HL7 single listener logical link for your device, you need to 
create a new logical link or edit an existing one.  
 

1. Decide which port to use. The facility, along with IRM, determines which port to use. 
This is the port used by the device to send data to the VistA listener. You can, for 
example, use port 1026 for Hemodialysis results and port 1027 for Sensormedics results. 
Do not use port 5000 for this type of setup. (See below for more information on port 
5000.)  

2. From the Systems Manager Menu, choose HL Main Menu (HL) > Interface Developer 
Options (IN) > Link Edit (EL). 

3. At the Select HL Logical Link Note prompt, enter the name of the new logical link for 
your device. Name your new logical link something like MCAR2 INST. The next one (if 
you use more than one high-volume device) can be called MCAR3 INST, etc.  

4. Type yes when asked if you are adding ‘MCAR2 INST’ as a new HL LOGICAL LINK. 
The HL7 LOGICAL LINK screen displays.  

 
                          HL7 LOGICAL LINK 
----------------------------------------------------------------------- 
 
          NODE: MCAR2 INST  
 
   INSTITUTION:  
 
MAILMAN DOMAIN:  
 
     AUTOSTART: Enabled  
 
    QUEUE SIZE: 100  
 
      LLP TYPE: TCP <RET> 
 
    DNS DOMAIN: 

 
Note: When this screen first displays for a new logical link, only the NODE and QUEUE SIZE 
fields will already contain values. The NODE field will display the logical link name you just 
created, and the QUEUE SIZE field will default to 10.  
 

 

5. Type Enabled in the Autostart field.  
6. Change the QUEUE SIZE value to 100. (Optional) 
7. Enter TCP in the LLP TYPE field, then press [Enter] to display the HL7 LOGICAL 

LINK screen (see following figure).  
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                          HL7 LOGICAL LINK 
 ----------------------------------------------------------------------------- 
  ┌─────────────────────TCP LOWER LEVEL PARAMETERS──────────────────────────┐ 
  │                     MCAR3 INST                                          │ 
  │                                                                         │ 
  │  TCP/IP SERVICE TYPE: SINGLE LISTENER                                   │ 
  │       TCP/IP ADDRESS:                                                   │ 
  │          TCP/IP PORT: 1026                                              │ 
  │          TCP/IP PORT (OPTIMIZED):                                       │ 
  │                                                                         │ 
  │   ACK TIMEOUT: 60                    RE-TRANSMISION ATTEMPTS: 3         │ 
  │  READ TIMEOUT:                     EXCEED RE-TRANSMIT ACTION: ignore    │ 
  │    BLOCK SIZE:                                      SAY HELO:           │ 
  │                                                                         │ 
  │STARTUP NODE: DEV:ISC4A2                           PERSISTENT: NO        │ 
  │   RETENTION:                            UNI-DIRECTIONAL WAIT:           │ 
  └─────────────────────────────────────────────────────────────────────────┘ 
 _____________________________________________________________________________ 
 

8. Set TCP/IP SERVICE TYPE to SINGLE LISTENER.  
9. In the TCP/IP PORT field, enter the port number you decided to use (in step 1). 
10. Optionally set ACK TIMEOUT to 60.  
11. Press [Tab] to optionally set RE-TRANSMISION ATTEMPTS to 3.  
12. Optionally set EXCEED RE-TRANSMIT ACTION to ignore. 
13. Enter the appropriate STARTUP NODE.  
14. Set the PERSISTENT field to NO.  
15. [Tab] down to the COMMAND prompt, then select Close. You return to the HL7 

LOGICAL LINK screen. 
16. [Tab] down to the COMMAND prompt, then select Save. 
17. At the COMMAND prompt, select Exit. 
18. The new link is useless until you assign protocols to it. Proceed to the next section to 

create a client protocol. 
 
Creating a Device Protocol Client 
You have to create a protocol for every inbound listener to VistA.  
 
To create a protocol client from for your new logical link using a copy, follow these steps: 
 

1. Look at the protocol in 101 or use developer tools. Copy MCAR DEVICE CLIENT to 
make a new device client. Name it something like MCAR2 DEVICE CLIENT.  

2. Change the entry in the Logical Link field to match the new logical link. For example, if 
you just created a logical link named MCAR2 INST, change what’s in the Logical Link 
field field from MCAR INST to MCAR2 INST. All other fields should match what was 
originally in MCAR DEVICE CLIENT.  

3. Proceed to the next section to make the new device protocol a subscriber to the device 
server. 

 
To create a new protocol client for your new logical link, do the following: 
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1. From the Systems Manager Menu, choose HL Main Menu (HL) > Interface Developer 
Options (IN) > Protocol Edit (EP). 

2. At the Select PROTOCOL NAME prompt, enter the name of the new device client for 
your device. Name your new device client something like MCAR2 Device Client or 
MCAR2 MUSE (depending on the device name). 

3. Type yes (or simply type y) when asked if you are adding ‘MCAR2 Device Client’ as a 
new PROTOCOL.  

4. Enter Instrument Device Client in the PROTOCOL ITEM TEXT field.  
5. Enter an appropriate identifier in the PROTOCOL IDENTIFIER field. The HL7 

INTERFACE SETUP screen displays. 
6. [Tab] down to the TYPE field and enter subscriber, then press [Enter] to display PAGE 

2 OF 2. 
 
                            HL7 SUBSCRIBER                        PAGE 2 OF 2 
                           MCAR2 Device Client            
----------------------------------------------------------------------------- 
 
      RECEIVING APPLICATION: MCAR INST      
 
      RESPONSE MESSAGE TYPE: ACK                            EVENT TYPE: R01 
 
 SENDING FACILITY REQUIRED?: NO           RECEIVING FACILITY REQUIRED?: NO  
 
         SECURITY REQUIRED?: 
 
               LOGICAL LINK: MCAR2 INST 
 
 PROCESSING RTN: D ^MDHL7A                                                     
 
  ROUTING LOGIC: 
_____________________________________________________________________________ 
 
 

7. Type MCAR-INST in the RECEIVING APPLICATION field, then enter the following 
entries: 

8. RESPONSE MESSAGE TYPE = ACK 
9. EVENT TYPE = R01 
10. SENDING FACILITY REQUIRED = NO 
11. RECEIVING FACILITY REQUIRED = NO 
12. LOGICAL LINK = MCAR2 INST (use the appropriate name) 
13. PROCESSING RTN = D ^ MDHL7A (use the appropriate routine) 

 
Note: The processing routine is the MUMPS routine that VistA uses to process the 
message received from the logical link.  

14. [Tab] down to the COMMAND prompt, then select Save. 
15. At the COMMAND prompt, select Exit. 
16. Proceed to the next section to make the new device protocol a subscriber to the device 

server. 
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Activating the Logical Links 
Next, the links need to be activated. (The steps below assume that the original logical link has 
never been activated. If MCAR INST is already active, skip to step 4.) 
 

1. Choose HL Main Menu (HL) > Filer and Link Management Options (FI) >Start/Stop 
Links (SL). 

2. Activate the first logical link: Select HL LOGICAL LINK NODE: MCAR INST   
3. Select B for Background. (B is the default, so just press [Enter]. 
4. Activate the next logical link: Select HL LOGICAL LINK NODE: (in this example it is 

MCAR2 INST)   
5. Select B for Background. (B is the default, so just press [Enter]. 
6. If you have more logical links to activate, repeat steps 4-5.  
7. If you haven’t done this already, use the CP Manager application to configure the device 

you are using.  Refer to Editing an Automated Instrument, p. 6-3. 
8. Proceed to the next section to make the new device protocol a subscriber to the device 

server. 
 
Adding a Device Client as a Server Subscriber 
Next you have to make the newly-created protocols subscribers to MCAR DEVICE SERVER. 
Every client must be a subscriber to a server. That controls the outbound message to a medical 
device when you reply to it. 
Go into MCAR DEVICE SERVER (under the protocol file or using the Interface Developer 
Option) and make sure that the new MCAR2 DEVICE CLIENT is a subscriber to it. Detailed 
steps follow: 

 

1. At the Select Systems Manager Menu, select HL for the HL7 Main Menu. 

2. At the Select HL7 Main Menu, select IN for Interface Developer Options.  

3. At Select Interface Developer Options, select EP for Protocol Edit. 

4. At the Select PROTOCOL NAME prompt, select MCAR Device Server. (If your site 
uses a different server name, select the appropriate name. You can display a list of 
available options, if necessary.) 

5. Press [Enter] at the TYPE prompt to go to PAGE 2 OF 2: the HL7 EVENT DRIVER 
screen. (Figure follows.) 
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                          HL7 EVENT DRIVER                        PAGE 2 OF 2 
                         MCAR Device Server             
----------------------------------------------------------------------------- 
      SENDING APPLICATION: INST-MCAR       
 TRANSACTION MESSAGE TYPE: ORU                        EVENT TYPE: R01 
        MESSAGE STRUCTURE: 
            PROCESSING ID: P                          VERSION ID: 2.3      
          ACCEPT ACK CODE:                  APPLICATION ACK TYPE: 
 
 RESPONSE PROCESSING RTN: 
                           SUBSCRIBERS 
  MCAR Device Client                                              
  MCAR Device Client2                                             
_____________________________________________________________________________ 

6. To add the new protocol as a subscriber, [Down Arrow] or [Tab] down to the line below 
MCAR Device Client and enter the name of the new subscriber (e.g., MCAR2 Device 
Client). The HL7 screen displays.  

7. Verify that the entries are correct, then [Down Arrow] down to the COMMAND line and 
select Close. You return to the MCAR Device Server screen.  

8. Repeat steps 6-7 if you need to add more subscribers.  

9. [Down Arrow] down to the COMMAND line and select Save.  

10. In the COMMAND line, select Exit.  
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1Using Port 5000 
Port 5000 is a Multi-Port Listener. The only reason to use the multiport listener is if your 
inbound port doesn’t work correctly because Cache is not handling ports correctly.  
If Cache is handling ports correctly, then you should let Cache handle them. Use the individually 
shared ports for your devices rather than using the Multi-Port Listener.  
If you’re at a facility that has listener problems under Cache, then use port 5000. Port 5000 is 
handled by VMS, not Cache.  
Most sites allocate 25 ports to port 5000, but more can be allocated, if necessary.   
 
Benefits of Using a Single Port Listener 
A single port is easier to monitor and debug. It’s easy to determine if the problem is caused by 
the link or something else. 
If you set up another Multi-Port Listener, you have to set it up in VMS. You’ll have to do that 
through UCX, which is a lot of work and beyond the scope of this document, 
 
Setting Up Port 5000 

1. Edit MCAR DEVICE CLIENT so the logical link points to VAxxx (where xxx is an 
abbreviation for the hospital). 

2. Make sure all CP Medical devices send to port 5000. 

3. You don’t need to set up an additional MCAR INST (logical link) because you’re using 
an existing logical link which is VAxxx, where xxx is an abbreviation for the hospital 
(e.g., VAHIN for Hines).  

4. Make it an MCAR DEVICE server subscriber.  
 
File Settings 
 
The parameter settings for the HL7 Application Parameter file, HL Logical Link file, and the 
Protocol file are automatically set during the CP installation.  They are listed here for reference.  
Fields that have bolded field names and bolded field entries must be set exactly as they appear in 
these examples. 
 

• HL7 Application Parameter (#771) file 
 
This file contains a list of VistA applications that are capable of sending and receiving HL7 
transmissions. 
 
NAME: MCAR-INST                         ACTIVE/INACTIVE: ACTIVE 
  FACILITY NAME: VISTA                  MAIL GROUP: POSTMASTER 
  COUNTRY CODE: US                      HL7 ENCODING CHARACTERS: ^~\& 
  HL7 FIELD SEPARATOR: | 
 
 
NAME: INST-MCAR                         ACTIVE/INACTIVE: ACTIVE 

                                                 
1 Patch MD*1.0*9  November 2007 Using Port 5000 with CACHE. 
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  COUNTRY CODE: US                      HL7 ENCODING CHARACTERS: ^~\& 
  HL7 FIELD SEPARATOR: | 
 

• HL Logical Link (#870) file 
 
This file stores parameters that govern the behavior of the Logical Links and also stores 
information that drives the SYSTEMS LINK MONITOR display option.  
 
NODE: MCAR INST                         LLP TYPE: TCP 
  QUEUE SIZE: 100                       RE-TRANSMISSION ATTEMPTS: 3 
  ACK TIMEOUT: 60                       EXCEED RE-TRANSMIT ACTION: ignore      
  TCP/IP PORT: 1026                     TCP/IP SERVICE TYPE: SINGLE LISTENER 
  PERSISTENT: NO                        
 
 
MCAR OUT provides an example of field entries for bi-directional instruments for outbound 
links to medical devices. The fields that have bolded field names and bolded field entries must be 
set exactly as they appear in this example. The other bolded fields must be edited to match your 
device specific requirements. For example, Device Type must be Non-Persistent Client.  Non-
bolded fields may not have a value depending on the state of the system.  
 
NODE: MCAR OUT                          LLP TYPE: TCP 
  DEVICE TYPE: Non-Persistent Client    STATE: Shutdown 
  AUTOSTART: Enabled                    TIME STOPPED: JAN 16, 2003@14:30:15 
  SHUTDOWN LLP ?: YES                   EXCEED RE-TRANSMIT ACTION: ignore 
  RE-TRANSMISSION ATTEMPTS: 3           TCP/IP PORT: 1028 
  ACK TIMEOUT: 60                       PERSISTENT: NO 
  TCP/IP ADDRESS: 10.3.17.202           STARTUP NODE: DEV:ISC4A2 
  TCP/IP SERVICE TYPE: CLIENT (SENDER)   
   
Note:  When you need to create additional HL7 links for new devices, name the link in the 

following format: 
 
- If you need to create more than one inbound link (MCAR INST), name the new links 

“MCAR”, followed by a number (1,2,3), a space, and then “INST”. 
 

Example: MCAR2  INST 
 

- Name outbound links “MCAR”, followed by a number (1,2,3), a space, and then a name 
for the device. 

 
Example: MCAR2 SMC 
 
See “Configuration Instructions Information” for information on setting the TCP/IP 
address and port and the Startup Mode.  

 
 

• Protocol (#101) file: 
 
This file contains the protocols for processing HL7 messages. 
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NAME: MCAR Device Client                ITEM TEXT: Instrument Device Client 
  TYPE: subscriber                      CREATOR: CPUSER, FIVE 
  PACKAGE: MEDICINE 
 DESCRIPTION:   Subscriber protocol for sending data to VISTA from clinical 
 instruments.   
  TIMESTAMP: 57540,31165                RECEIVING APPLICATION: MCAR INST 
  TRANSACTION MESSAGE TYPE: ORU         EVENT TYPE: R01 
  PROCESSING ID: P                      LOGICAL LINK: MCAR INST 
* VERSION ID: 2.3                       RESPONSE MESSAGE TYPE: ACK 
  PROCESSING ROUTINE: D ^MDHL7A         SENDING FACILITY REQUIRED?: NO 
  RECEIVING FACILITY REQUIRED?: NO 
 
 
NAME: MCAR Device Server                ITEM TEXT: Instrument HL7 Event Driver 
  TYPE: event driver                    CREATOR: CPUSER, FIVE 
  PACKAGE: MEDICINE 
 DESCRIPTION:   This protocol is used by the HL7 package to send results to  
 VISTA from various clinical instrumentation.   
  TIMESTAMP: 57631,55707                SENDING APPLICATION: INST-MCAR 
  TRANSACTION MESSAGE TYPE: ORU         EVENT TYPE: R01 
  PROCESSING ID: P                    * VERSION ID: 2.3 
  SENDING FACILITY REQUIRED?: NO        RECEIVING FACILITY REQUIRED?: NO 
SUBSCRIBERS: MCAR Device Client 
 
NAME: MCAR ORM CLIENT                   TYPE: subscriber 
  CREATOR: CPUSER, SIX                  RECEIVING APPLICATION: INST-MCAR 
  EVENT TYPE: O02                       RESPONSE MESSAGE TYPE: ORR 
  SENDING FACILITY REQUIRED?: NO        RECEIVING FACILITY REQUIRED?: NO 
  SECURITY REQUIRED?: NO                ROUTING LOGIC: Q 
 
NAME: MCAR ORM SERVER 
  ITEM TEXT: Clinical Procedures ORM Protocol Server 
  TYPE: event driver                    CREATOR: CPUSER, SIX 
  TIMESTAMP: 59276,54156                SENDING APPLICATION: MCAR-INST 
  TRANSACTION MESSAGE TYPE: ORM         EVENT TYPE: O01 
  VERSION ID: 2.3 
SUBSCRIBERS: MCAR ORM CLIENT 
 
*Note:  Check vendor documentation for instructions on verifying the Version ID.  
 
Technical Issues 
 

For all sites: 
 
To avoid error messages because of a missing or invalid 'Event Protocol', 'Invalid 
Processing Code', or 'Invalid Application Code', make sure that all settings (except 
TCP/IP PORT and TCP/IP ADDRESS, in the HL Logical Link (#870) file, which are site 
specific) are the same as the file settings listed previously in this chapter. 
 

Be sure that the VERSION ID parameters in the Protocol (#101) file are set to the same HL7 
Version that is being sent by the vendor instrument.  The ITEM and SUBSCRIBERS fields in 

11-10 Clinical Procedures V. 1.0 April 2004 
 Implementation Guide 



Setting Up HL7 Parameters 
 

the Device Server entry in the Protocol (#101) file MUST be the same as the Device Client 
name. 
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12. Configuring the Automated Instrument Share Folder 
 
CP uses VistA Imaging as the main storage facility for the images and documents that come 
from a medical device.  After one or more medical devices have been installed at the facility, you 
need to complete the setup.  The vendor can provide you with the directory that is used to store 
the images and documents.  You need to make that directory viewable to the VistA Imaging 
background processor, which will allow VistA Imaging to retrieve the document and store it on 
the VistA jukebox. 
 
Here is a list of information you need to ensure that the share folder is set up correctly: 
 

• Directory name that holds the documents and images on the medical device.  Be sure to 
get the directory name from the vendor when the device is installed. 

• VistA Imaging User (IU) and VistA Imaging Administrator (IA) accounts that are used 
when starting up the VistA Imaging background processor.  You can get these names 
from the VistA Imaging coordinator at your facility.  

• The medical device and the Imaging background processor must be on the same 
Windows domain. 

• The medical device must have the same TCP/IP subnet mask as the Imaging background 
processor. 

• You need administration privileges to complete the setup. 
• You need to make the directory viewable on the medical device that has the documents 

and images. 
• The network path to the results folder cannot contain symbols, such as dollar signs ($). 
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Example: Setting up an automated instrument share folder: 
 
This example describes how to share a Windows 2000 directory for the Widget EKG automated 
instrument where the medical device (Widget EKG) and the Imaging background processor are 
on the same domain VHAExample and subnet 255.255.240.0. 
 
The directory that has the documents and images is C:\widget\doc.  The VistA Imaging user is 
VHAISHIU and has an administrator logon to Windows. 
 

1. Using Windows Explorer, go to the parent directory of the folder that contains the 
folder to be shared (doc folder) (Figure 12-1). 

 

 
Figure 12-1 

 
2. Right-click the doc folder.  Select Sharing from the drop-down menu.  The 

Sharing tab on the doc properties dialog box is displayed, Figure 12-2. 
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Figure 12-2 

 
3. Click Share this folder. 
4. Click Permissions.   
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Figure 12-3 

 
5. Select Everyone, and then click Remove. (Figure 12-3). 
6. Click Add.  The Select Users, Computers, or Groups window is displayed. 
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Figure 12-4 

 
7. Enter the name of the VistA Imaging (VHAISHIU) User (IU) into the bottom 

window and click Check Names.  A line is displayed under the name if it is valid.  
Click OK to add the user (Figure 12-4).  The Select Users, Computers, or Groups 
window closes and VHAISHIU is displayed in the Permissions dialog box.   

 

April 2004 Clinical Procedures V. 1.0 12-5 
 Implementation Guide 



Configuring the Automated Instrument Share Folder 

 
Figure 12-5 

 
8. Make sure the check boxes are selected in the  “Allow” column for “Full 

Control”, “Change” and “Read” (Figure 12-5).  
9. Click Apply and then click OK.  A hand displays under the file, which means that 

the file is now accessible to the VistA Imaging user. 
10. To test that the shared folder is set up correctly, have the VistA Imaging 

coordinator logon as VHAISHIU on a different PC.  Check that the shared folder 
is viewable. 
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13. Troubleshooting 
 
Here are frequently encountered errors and resolutions that can occur while running Clinical 
Procedures. To resolve most of these errors, you need access to CP Manager and CP User. 
 
1. You tried to launch a CP application and received the following error:   

 

 
Figure 13-1 

 
a) Highlight the CP application icon on your desktop. (When CP in installed, shortcuts for 

the applications are created on the desktop.)  
b) Right-click, and then click Properties. 
c) Enter the command line switch “/nonsharedbroker” in the Target field. 
d) Press OK. 

 
You can also add the “/nonsharedbroker” switch to the applications in Start > Programs > 
Clinical Procedures.  

 
 
2. If you receive the following error: 

 

 
Figure 13-2 

 
You need the MD GUI USER option to access CP User and the MD GUI MANAGER option to 
access CP Manager. Call IRM. 
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3. During a CP Study Check-In, a procedure request was ordered but is not listed. 

 
a) The GRMC procedure has not been linked to a CP procedure. You need to cancel the 

procedure request, and then use the following Procedure Setup option to link the GMRC 
procedure to the CP procedure. 

 
Select OPTION NAME: GMRC MGR       Consult Management 

 
Select Consult Management Option:  PR   Setup procedures 
Select Procedure:CP EKG 12 LEAD STAT 
NAME:  CP EKG 12 LEAD STAT//  <RET> 
INACTIVE: NO// <RET> 
Select SYNONYM: EKG// <RET> 
INTERNAL NAME: <RET> 
Select RELATED SERVICES: CP CARDIOLOGY// <RET> 
TYPE OF PROCEDURE: ECG// <RET> 
CLINICAL PROCEDURE: EKG, ROUTINE (12 LEADS)// <RET> 
 
If you entered “?” in the Clinical Procedure field and you do not find a procedure that you 
want, use CP Manager to define and activate the CP procedures. 
 

b) Open CP Manager. 
c) Enter the name of the CP Procedure in the Procedure Name field. See Setting Up 

Clinical Procedures, p. 6-1. 
d) Re-order the consult procedure. 

 
 

4. Allowable Instruments are associated with the CP procedure but you cannot see the 
instruments during Study Check-In. 

 
a) Open CP Manager. 
b) Expand the Procedures folder, and then select the procedure. 
c) In the Allowable Instruments list, select the check box for the specific instrument. 

 
 
5. After a study is checked-in, you can’t find the study entry in CP User. 

 
a) Open CP Manager. 
d) Expand the Procedures folder, and then select the procedure. 
b) Check that a treating specialty has been assigned.   
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Figure 13-3 

 
6. An error status is displayed for the study and the Update Study Status selection is 

unavailable. You must have the MD GUI MANAGER key, and then you can go to File > 
Update Study Status to review the problem.    
 
The message in the following figure indicates that a Notification Mailgroup has not been 
assigned or the Medical Device is not Active.  
 

 
Figure 13-4 
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a) Open CP Manager. 
b) Select the instrument. 
c) Check that the Notification Mail Group has an entry and that the Active checkbox is 

selected. 
d) Open CP User. Choose File > Update Study Status. 
e) If the device is bi-directional, delete the study that was checked in and check-in a new 

study with the same procedure request to get the HL7 message transmitted to the medical 
device.   If the device is uni-directional, check the Ready to Complete status, and click 
OK.  

 
 
7. If a study remains in Pending Instrument Data status and it is a bi-directional medical 

device, check to see if Auto Submit To VistA Imaging field is selected.  . 
 

a) Open CP Manager. 
b) Expand the Procedures folder, and then select the procedure 
c) Check that Auto Submit to VistA Imaging is selected. 
 

For the current study, you still need to manually submit the result. For future studies, the result 
will be automatically submitted. 
 
 
8. The following two errors indicate that a TIU document Title has not been assigned to the CP 

procedure.  The first error message is from CP during image submission if a TIU document 
has not been assigned to the CP Definition. 

 
 

 
Figure 13-5 

 
This second error screen is the Update Study Status screen from CP User.  The first message is a 
CP warning.  The second message is a warning from TIU that there is no TIU document. 
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Figure 13-6 

 
a) Open CP Manager  
b) Select the procedure, and check that a TIU Note Title is assigned. 
c) Open CP User and Update the Study Status to Ready to Complete. 
d) Open the study and manually submit the results. By manually submitting the result, you 

prevent any re-occurrences of the error.  
 

 
9. These errors indicate that a Hospital Location has not been defined for the CP procedure. 
 

 
Figure 13-7 
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Figure 13-8 

 
a) Open CP Manager and check that the Hospital Location has been defined.   
b) Open CP User and Update the Study Status to Ready to Complete. 
c) Open the study and submit it manually. 
 

 
10. If the Complete/Update Result option in CPRS > Action > Consults Results is 

unavailable, you need to be updated as the Interpreter. Use the Service User Management 
> SERVICE INDIVIDUAL TO NOTIFY option to assign the Interpreter role. 

 
Select Consult Management Option: SU Service User Management 
 
Select Service/Specialty:   GASTROENTEROLOGY      
Select UPDATE USERS W/O NOTIFICATIONS: CPUSER, SEVEN 
         //  
Select UPDATE USERS W/O NOTIFICATIONS:  
Select ADMINISTRATIVE UPDATE USER: CPUSER, EIGHT 
         //   
Select ADMINISTRATIVE UPDATE USER:  
SERVICE INDIVIDUAL TO NOTIFY: CPUSER, NINE       CD     123     IRM FIELD 
OFFICE     IRM FIELD OFFICE   
   PROGRAMMER 
Select SERVICE TEAM TO NOTIFY: consultteam//  
Select NOTIFICATION BY PT LOCATION:  
 
Select Service/Specialty: 
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11. If you get the following error message: 
 

 
Figure 13-9 

 
Make sure that the Imaging Background Processor can access the Network Share, where the 
result resides.  
 

a) Open CP Manager. 
b) Click Clinical Procedures. 
c) Click System Parameters. 
d) Check the path of the Imaging Network Share.   (The Imaging Network Share must 

be a shared directory that can be accessed by the Imaging Background Processor and 
CP Gateway.) 

 
 
12. If a study remains in “Submitted” status, check the Imaging Background Processor log for 

errors and make sure that the  “Import” checkbox is checked for the Import BP parameter.  
 
From the Background Processor, choose Edit > BP Workstation Parameters.  (You may 
need to find someone who is responsible for the Imaging Background Processor application.) 
 
 

13. If the Interpreter does not receive an alert that the procedure is ready for interpretation, check 
if the CONSULT/PROC INTERPRETATION notification is enabled and if the user has 
the Interpreter role. 

 
a) You must enable the CONSULT/PROC INTERPRETATION notification if you want to 

receive the “Ready for interpretation” alert in CPRS.  You can enable the alert for one 
user, several users, or for the entire service.  Use the Notification Management Menu.  
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b) To assign the interpreter role, use the Consult Management menu.  If user wants to 
receive alerts, do not enter them into the Update Users W/O Notifications field.  This 
field is for users who want the role of interpreter but do not want to receive alerts.  Refer 
to Setting Up Consult Services, p. 8-1. 

 
Select Consult Management Option: SU  Service User Management 
 
Select Service/Specialty:    GASTROENTEROLOGY      
Select UPDATE USERS W/O NOTIFICATIONS: CPUSER, SEVEN 
         //  
Select UPDATE USERS W/O NOTIFICATIONS:  
Select ADMINISTRATIVE UPDATE USER: CPUSER, EIGHT 
         //  
Select ADMINISTRATIVE UPDATE USER:  
SERVICE INDIVIDUAL TO NOTIFY: CPUSER, NINE       CD     123     IRM FIELD 
OFFICE     IRM FIELD OFFICE   
   PROGRAMMER 
Select SERVICE TEAM TO NOTIFY: consultteam//  
Select NOTIFICATION BY PT LOCATION:  
 
 
14. If you receive the following error while trying to interpret a procedure: 
 

 
Figure 13-10 

 
This message can occur if business rules have not been set up or if insufficient business rules 
have been set up for this document title.  
 
To add a business rule: 

 
a) Go into the User Class Management Menu. 
b) Select Manage Business Rules. 
c) Enter specific words at the appropriate prompts (Status, Action, User Class).  These 

words are combined to make a business rule.  
 
 

 

13-8 Clinical Procedures V. 1.0 April 2004 
 Implementation Guide 



 

14. Glossary 
 
Access Code   A unique sequence of characters known by and assigned only to the user, the 

system manager and/or designated alternate(s).  The access code (in conjunction with the 
verify code) is used by the computer to identify authorized users. 

 
Action   A functional process that a clinician uses in a computer program.  For example, “Edit” 

and “Search” are actions.  Protocol is another name for Action. 
 
ADP Coordinator/ADPAC/Application Coordinator   Automated Data Processing 

Application Coordinator.  The person responsible for implementing a set of computer 
programs (application package) developed to support a specific functional area such as 
clinical procedures, PIMS, etc. 

 
Application   A system of computer programs and files that have been specifically developed to 

meet the requirements of a user or group of users.  
 
Archive   The process of moving data to some other storage medium, usually a magnetic tape, 

and deleting the information from active storage in order to free-up disk space on the system. 
 
ASU   Authorization/Subscription Utility, an application that allows sites to associate users with 

user classes, allowing them to specify the level of authorization needed to sign or order 
specific document types and orderables.  ASU is distributed with TIU in this version.  

 
Attachments   Attachments are files or images stored on a network share that can be linked to 
the CP study.   CP is able to accept data/final result report files from automated instruments. The 
file types that can be used as attachments are the following: 
 

 .txt  Text files 
 .rtf Rich text files 
 .jpg JPEG Images 
 .jpeg JPEG Images 
 .bmp Bitmap Images 
 .tiff TIFF Graphics (group 3 and group 4 compressed and uncompressed types)  
 .pdf Portable Document Format 
 .html Hypertext Markup Language  
 
.DOC (Microsoft Word files) are not supported. Be sure to convert .doc files to .rtf or to 
.pdf format. 

 
Automatic Version Updates   Updating an account with new software versions without user 

intervention. 
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Background Processing   Simultaneous running of a "job" on a computer while working on 
another job.  Examples would be printing of a document while working on another, or the 
software might do automatic saves while you are working on something else. 

 
Backup Procedures   The provisions made for the recovery of data files and program libraries 

and for restart or replacement of ADP equipment after the occurrence of a system failure. 
 
Boilerplate Text   A pre-defined TIU template that can be filled in for titles to speed up the 

entry process.  TIU exports several titles with boilerplate text, which can be modified to meet 
specific needs; sites can also create their own. 

 
Browse   Lookup the file folder for a file that you would like to select and attach to the study.  

Such as clicking the “...” button to start a lookup. 
 

Bulletin   A canned message that is automatically sent by mail to a user when something 
happens to the database. 

 
Business Rule   Part of ASU, Business Rules authorize specific users or groups of users to 

perform specified actions on documents in particular statuses (e.g., an unsigned CP note may 
be edited by a provider who is also the expected signer of the note). 

 
Class   Part of Document Definitions, Classes group documents.  For example, “CLINICAL 

PROCEDURES” is a class with many kinds of Clinical Procedures notes under it.  Classes 
may be subdivided into other Classes or Document Classes.  Besides grouping documents, 
Classes also store behavior which is then inherited by lower level entries. 

 
Consult   Referral of a patient by the primary care physician to another hospital service/ 

specialty, to obtain a medical opinion based on patient evaluation and completion of any 
procedures, modalities, or treatments the consulting specialist deems necessary to render a 
medical opinion. 

 
Contingency Plan   A plan that assigns responsibility and defines procedures for use of the 

backup/restart/recovery and emergency preparedness procedures selected for the computer 
system based on risk analysis for that system. 

 
CP   Clinical Procedures. 
 
CP Study   A CP study is a process created to link the procedure result from the medical device 

or/and to link the attachments browsed from a network share to the procedure order. 
 
CPRS   Computerized Patient Record System.  A comprehensive VistA program, which allows 

clinicians and others to enter and view orders, Progress Notes and Discharge Summaries 
(through a link with TIU), Problem List, view results, and reports (including health 
summaries). 

 
Device   A hardware input/output component of a computer system, such as CRT, printer. 

14-2 Clinical Procedures V. 1.0 April 2004 
 Implementation Guide 



Glossary 

 
Document Class   Document Classes are categories that group documents (Titles) with similar 

characteristics together.  For example, Cardiology notes might be a Document Class, with 
Echo notes, ECG notes, etc. as Titles under it.  Or maybe the Document Class would be 
Endoscopy Notes, with Colonoscopy notes, etc. under that Document Class. 

 
Document Definition   Document Definition is a subset of TIU that provides the building blocks 

for TIU, by organizing the elements of documents into a hierarchy structure.  This structure 
allows documents (Titles) to inherit characteristics (such as signature requirements and print 
characteristics) of the higher levels, Class and Document Class.  It also allows the creation 
and use of boilerplate text and embedded objects. 

 
Edit   Used to change/modify data typically stored in a file. 
 
Field   A data element in a file.  
 
File   The M construct in which data is stored for retrieval at a later time.  A computer record of 

related information. 
 
File Manager or FileMan   Within this manual, FileManager or FileMan is a reference to VA 

FileMan.  FileMan is a set of M routines used to enter, edit, print, and sort/search related data 
in a file, a database.   

 
File Server   A machine where shared software is stored. 
 
Gateway   The software that performs background processing for Clinical Procedures.  
 
GUI   Graphical User Interface – a Windows interface that uses pull-down menus, icons, 

pointer devices, and other metaphor-type elements that make a computer program, 
easier to use and that allows multi-processing (more than one window or process 
available at once). 

 
Interpreter   Interpreter is a user role exported with USR*1*19 to support the Clinical 

Procedures Class.  The role of the Interpreter is to interpret the findings or results of a 
clinical procedure.  Users who are authorized to interpret the results of a clinical procedure 
are sent a notification when an instrument report and/or images for a CP request are available 
for interpretation.  Business rules are used to determine what actions an interpreter can 
perform on a document of a specified class, but the interpreter themselves are defined by the 
Consults application.  These individuals are ‘clinical update users’ for a given consult 
service.   

 
IRMS   Information Resource Management Service. 
 
Kernel   A set of software utilities.  These utilities provide data processing support for the 

application packages developed within the VA.  They are also tools used in configuring the 
local computer site to meet the particular needs of the hospital.  The components of this 
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operating system include: MenuMan, TaskMan, Device Handler, Log-on/Security, and other 
specialized routines. 

 
M   Formerly known as MUMPS or the Massachusetts (General Hospital) Utility Multi-

Programming System.  This is the programming language used to write all VistA 
applications. 

 
Menu   A set of options or functions available to users for editing, formatting, generating 

reports, etc. 
 
Modality   Another name for a medical instrument. 
 
Module   A component of a software application that covers a single topic or a small section of a 

broad topic. 
 
Namespace   A naming convention followed in the VA to identify various applications and to 

avoid duplication.  It is used as a prefix for all routines and globals used by the application.  
 
Network Server Share   A machine that is located on the network where shared files are stored. 
 
Notebook   This term refers to a GUI screen containing several tabs or pages. 
 
Option   A functionality that is invoked by the user.  The information defined in the option is 

used to drive the menu system.  Options are created, associated with others on menus, or 
given entry/exit actions.  

 
Package   Otherwise known as an application.   
 
Page   This term refers to a tab on a GUI screen or notebook. 
 
Password   A protected word or string of characters that identifies or authenticates a user, a 

specific resource, or an access type (synonymous with Verify Code). 
 
Pointer   A special data type of VA FileMan that takes its value from another file.  This is a 

method of joining files together and avoiding duplication of information.   
 
Procedure Request   Any procedure (EKG, Stress Test, etc.) which may be ordered from 

another service/specialty without first requiring formal consultation. 
 
Queuing   The scheduling of a process/task to occur at a later time.  Queuing is normally done if 

a task uses up a lot of computer resources. 
 
Result   A consequence of an order.  Refers to evaluation or status results.  When you use the 

Complete Request (CT) action on a consult or request, you are transferred to TIU to enter the 
results. 

 

14-4 Clinical Procedures V. 1.0 April 2004 
 Implementation Guide 



Glossary 

Security Key   A function which unlocks specific options and makes them accessible to an 
authorized user. 

 
Sensitive Information   Any information which requires a degree of protection and which 

should be made available only to authorized users. 
 
Site Configurable   A term used to refer to features in the system that can be modified to meet 

the needs of each site. 
 
Software   A generic term referring to a related set of computer programs.   
 
Status Symbols   Codes used in order entry and Consults displays to designate the status of the 

order. 
 
Study   See CP Study.  
 
Task Manager or TaskMan   A part of Kernel which allows programs or functions to begin at 

specified times or when devices become available.  See Queuing. 
 
Title   Titles are definitions for documents.  They store the behavior of the documents which use 

them. 
 
TIU   Text Integration Utilities. 
 
User   A person who enters and/or retrieves data in a system. 
 
User Class   User Classes are the basic components of the User Class hierarchy of ASU 

(Authorization/Subscription Utility) which allows sites to designate who is authorized to do 
what to documents or other clinical entities. 

 
User Role   User Role identifies the role of the user with respect to the document in question, 

such as Author/Dictator, Expected Signer, Expected Cosigner, Attending Physician, etc.. 
 
Verify Code   A unique security code which serves as a second level of security access.  Use of 

this code is site specific; sometimes used interchangeably with a password. 
 
VistA   Veterans Health Information Systems and Technology Architecture. 
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15. Appendix A – CP Application Startup Options and 
Command Line Switches 

 
Topics discussed in this chapter are: 
 

• Introduction 
• What is a Command Line Switch? 
• Shared Broker Environment 
• CPRS Tools Menu 
• All Command Line Switches 

 
 
Introduction 
 
Clinical Procedures was designed to operate as a standalone client or, when desired, launched 
from the tools menu of CPRS.  CP uses the new Shared Broker environment and is also 
backwards compatible with previous releases of the RPC Broker.  This functionality is achieved 
through the use of command line switches, which are applied to the Desktop Icons, Start Menu 
items, or the command assigned to an item on the CPRS tools menu. 
 
 
What is a Command Line Switch? 
 
A command line switch is a setting that is included in the call to the executable that controls the 
behavior of the executable.  A common switch setting deployed in the VistA environment 
specifies the proper server on the proper listener port for the RPC Broker to connect to without 
user intervention.  This is commonly seen when you create a desktop icon for CPRS with the 
/s=BrokerServer /p=9200 switch.  The connection to the VistA server is defined as BrokerServer 
on listener port 9200.  (See the RPC Broker manuals for a complete description of defining a 
valid connection to pass to applications.) 
 
 
Shared Broker Environment 
 
CP was developed when the Shared Broker was being implemented.  The Shared Broker 
provides a more responsive workstation environment by eliminating multiple sign-on 
requirements and preserving VistA server resources by combining several client applications 
into a single process/connection.  CP provides this new functionality.  
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To assist sites in the migration to Shared Broker, CP is backwards compatible with the previous 
RPC Broker environment with a simple command line switch in the desktop icon, start menu 
item, and CPRS Tools Menu items.  During the client GUI installation, desktop icons and start 
menu items are installed using the command line switch, /NonSharedBroker.  By appending this 
command line switch, a call to launch a CP application causes the application to run with the old 
style broker and does not require that the workstation be upgraded with the latest broker client 
software. 
 
Example: 
 
\\MyAppServer\CP\CPuser.exe /server=BrokerServer /Port=9200 /NonSharedBroker 
 
In this example, CPUser is executed from the server MyAppServer in share name CP and tries to 
connect to the VistA server defined as BrokerServer on listener port 9200.  In addition, this 
command causes CPUser to connect to the previous version of the broker instead of the Shared 
Broker. 
 
 
CPRS Tools Menu 
 
If you want to use CP User from the CPRS tools menu, you need to launch CP User in a mode 
that causes it to listen to CPRS for patient changes and to exit when CPRS is closed.  When 
appending the command line switch /cprs to the command in the CPRS Tools Menu command 
line, CP runs in a slave mode and does not allow patients to be selected within the CP 
environment.  CPRS provides placeholders for the site to utilize when creating command lines 
for the tools menu.  These are: 
 
 %srv Holds the name of the server that CPRS is currently connected to. 
 %port Holds the listener port that CPRS is currently communicating through. 
 %dfn Holds the DFN of the currently opened patient record in CPRS. 
 
Example command line for CPRS tools menu: 
 
CPUser=\\MyAppServer\CP\CPuser.exe /cprs /server=%s /port=%p /dfn=%d 
 
In this example, the CPUser.exe on server MyAppServer in the Share CP runs as a slave under 
the CPRS application while connecting to the server that CPRS defined in %s on the listener port 
defined in %p.  In addition, CP User opens the patient defined in %d upon starting. 
 
For instructions on setting up the CPRS Tools menu, refer to, Adding Clinical Procedures to the 
CPRS Tools Menu, p. 9-7
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All Command Line Switches 
 
Clinical Procedures V. 1.0 command line parameters available from the command prompt or 
within Windows shortcut definitions and the CPRS Tools menu commands are defined by 
application. 
 
CP User.exe [/server=servername] [/port=listenerport] [/cprs] [/dfn=patientdfn] 

[/helpdir=helpdirectory] [/debug={on|off}] [/brokertimeout=seconds] 
[/bypasscrc] [/NonSharedBroker] 

 
CP Manager.exe [/server=servername] [/port=listenerport] [/helpdir=helpdirectory] 

[/debug={on|off}] [/brokertimeout=seconds] [/bypasscrc]  
[/NonSharedBroker] 

 
CP Gateway.exe [/server=servername] [/port=listenerport] [/helpdir=helpdirectory] 

[/debug={on|off}] [/brokertimeout=seconds] [/bypasscrc]  
[/NonSharedBroker] 

 
Switches: 
Name Description Default 
/server Specifies a VistA server to which you are 

connected.   
BROKERSERVER 

/port Specifies an alternate listener port on the 
selected server. 

9200 

/cprs Specifies that the application is to run in 
slave mode under CPRS.  This switch must 
be utilized when adding the CP User 
application to the CPRS tools menu. 

 

/dfn Specifies the patient dfn (record identifier) 
to open upon application startup.  This 
switch must be utilized when adding the CP 
User application to the CPRS tools menu. 

 

/helpdir Location of the Clinical Procedures 
windows help files. 

../appdir/help of the 
application. 

/debug Sets the debug mode for both the RPC 
Broker and the Clinical Procedures 
application. 

Off 

/brokertimeout Overrides the timeout for the RPC Broker 
when executing a Remote Procedure. 

30 
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Name Description Default 
/bypasscrc Overrides the system parameters setting to 

check an applications crc32 value upon 
application startup.  This switch should 
only be used during testing to avoid the 
messages if the site is implementing CRC 
verification. 

 

/NonSharedBroker This switch instructs the application to not 
utilize the shared broker functionality.  
Used when the Shared Broker has not been 
implemented on the target workstation. 

 

 
servername IP Address or Name of VistA server as it appears in the client Hosts. file. 
 Default Hosts. file locations: 
 NT 4.0 = c:\winnt\system32\drivers\etc\hosts. 
 Win95/98 = c:\windows\hosts. 
listenerport TCP Port that the Broker is running on the VistA server. 
 
helpdirectory Directory path to a location containing the Clinical Procedures V. 1.0 Help 

Files. 
seconds Integer value specifying the number of seconds the RPC Broker waits for a 

server response to an RPC. 
patientdfn Value of the patient dfn to access when starting the CP User application. 
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16. Appendix B – Exported Procedures List 
 
These exported procedures are contained in the MDPOST routine.  When the INIT^MDPOST 
routine is run, these entries are added to your CP Definition (#702.01) file: 
 
        ABD PARACENTESIS: FOLLOWUP 
        ABD PARACENTESIS: INITIAL 
        ABLATION OF AV NODE FUNCTION 
        AICD INTER/CONDITION 
        AIRWAY RESISTANCE 
        ANO BIOPSY 
        ANO CONTROL BLEEDING 
        ANO DIAGNOSTIC (BRUSHINGS) 
        ANO HOT BIOPSY(IES) 
        ANO SINGLE TUMOR (HOT/BICAP) 
        ANOSCOPY 
        ARRHYTHMIA INDUCTION BY PACING 
        ARTERIAL BLOOD GASES 
        ARTERIAL CANNULATION 
        ARTERIAL PUNCTURE 
        ARTHROC.ASPIR.INJ.INT.JT.BUR 
        ARTHROC.ASPIR.INJ.MAJ.JT.BUR 
        ARTHROCENT.ASPIR.INJ.SM.JT.BUR 
        ASPIRATION 
        BIOPSY 
        BIOPSY LUNG, PERCUTANEOUS NDL 
        BIOPSY, PLEURA 
        BONE MARROW 
        BONE MARROW INTERPRETATION 
        BRONC DIAGNOSTIC W/BAL 
        BRONC W/BRONC WASHING 
        BRONC W/TRANSBRONC LUNG BX 
        BRONCHIAL BRUSH 
        BRONCHOSCOPY W/BRONCH BIOPSY 
        BRONCHOSCOPY W/WANG NEEDLE 
        BRONCHOSCOPY, LASER 
        BRONCHOSCOPY, STENT PLACEMENT 
        BRONCHOSCOPY, THERAPEUTIC 
        BRONCOSCOPY/FB REMOVAL 
        C&P EXAM 
        CARDIAC CATHETERIZATION 
        CARDIAC REHAB W/O ECG MON 
        CARDIAC REHAB/W ECG MON 
        CARDIOPULMONARY REHABILITATION 
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        CARDIOVERSION, ELECTIVE 
        CENTRAL VENOUS CANNULATION 
        CHEMOTHERAPY 
        COL ABL (OTHR THAN SNARE/BI) 
        COL BIOPSY 
        COL CONTROL HEM. 
        COL DIAGNOSTIC (BRUSHINGS) 
        COL HOT BIOPSY(IES) 
        COL REMOVAL FB 
        COL SNARE 
        COLONOSCOPY 
        COMPREHENSIVE EP EVALUATION 
        CPAP/BIPAP VENTILATION 
        DIALYSIS PROCEDURES, HEMO 
        DIALYSIS TRAINING/COMPLETE 
        DIFFUSION 
        DILUTION STUDIES FOR CO MEAS 
        ECG 
        ECG (EKG), RHYTHM STRIP 
        ECG 12 LEAD 
        ECG 24 HOUR HOLTER MONITOR 
        ECG MONITORING 
        ECG WITH INTERPRETATION 
        ECG, EVENT RECORDER 
        ECG, RHYTHM TRACING 
        ECG, SIGNAL AVERAGE 
        ECHO 
        ECHO TRANSESOPHOGEAL SINGLE PL 
        ECHO, 2D M-MODE 
        ECHO, DOPPLER COLOR FLOW 
        ECHO, DOPPLER, COMPLETE 
        ECHO, TRANSESOPHOGEAL 
        ECHO, TRANSESOPHOGEAL BIPLANE 
        ECHO, TRANSTHORACIC 
        EGD 
        EGD ABL (OTH THAN SNARE/BI) 
        EGD BAND LIGATION 
        EGD BIOPSY 
        EGD DIAGNOSTIC (BRUSHINGS) 
        EGD DILATION BALLOON 
        EGD DILATION WIRE 
        EGD FOREIGN BODY 
        EGD HOT BIOPSY(IES) / BICAP 
        EGD INJECTION / SCLEROSIS 
        EGD SNARE/SINGLE 
        EGD TUBE/STENT 
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        EKG, ROUTINE (12 LEADS) 
        ENDO OF BOWEL POUCH W/ BIOPSY 
        ENDOMYOCARDIAL BIOPSY 
        ENDOSCOPIC ULTRASOUND 
        ENDOSCOPIC ULTRASOUND, BIOPSY 
        ENDOSCOPY OF BOWEL POUCH 
        ENDOTRACHEAL INTUBATION 
        ENTEROSCOPY 
        EP EVAL OF CARDIO/DEFIB LEADS 
        EP EVAL OF CARDIOVERTER/DEFIB 
        EP EVAL W/ ARRHYTHMIA INDUCT 
        EP EVAL W/ L ATRIAL RECORD 
        EP EVAL W/ L VENTRIC RECORD 
        EP FOLLOWUP STUDY W/PACING 
        EP STUDY 
        EPICARDIAL/ENDOCARDIAL MAPPING 
        ERCP 
        ERCP ABL (OTHR THAN SN/BI) 
        ERCP BALLOON DILATION 
        ERCP BIOPSY 
        ERCP DEST STONES 
        ERCP DIAGNOSTIC (BRUSHINGS) 
        ERCP DRAIN, TUBE 
        ERCP INSERTION OF TUBE/STENT 
        ERCP PRESSURE OF ODDI 
        ERCP REM STONES 
        ERCP RMV FB OR CHG OF TUBE 
        ERCP SPHINCTEROTOMY 
        ES ABLATION (OTHER) 
        ES BAND LIGATION 
        ES BIOPSY 
        ES CONTROL BLEEDING 
        ES DIAGNOSTIC ENDO (BRUSHINGS) 
        ES DILATION (BALLOON) 
        ES DILATION (WIRE) 
        ES HOT BIOPSY(IES) 
        ES INJECTION / SCLEROSIS 
        ES INSERTION TUBE/STENT 
        ES REMOVAL FB 
        ES SNARE 
        ESOPHAGEAL DILATION 
        ESOPHAGEAL MOTILITY STUDY 
        ESOPHAGEAL RECORDING 
        ESOPHAGUS 
        ETT 
        ETT W/ O2 CONSUMPTION 
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        ETT W/ THALLIUM SCAN 
        EXAM,SYNOVIAL FLUID CRYSTALS 
        EXCERCISE CHALLENGE 
        FINE NEEDLE ASPIRATION 
        FLEX SIG 
        FLOW VOLUME LOOP 
        FLX ABLATION (OTHER) 
        FLX BIOPSY 
        FLX CONTROL HEM. 
        FLX DECOMPRESS VOLVULUS 
        FLX DIAGNOSTIC (BRUSHINGS) 
        FLX HOT BIOPSY(IES) 
        FLX REMOVAL FB 
        FLX SNARE 
        FRC 
        FT CHANGE OF G TUBE 
        FT EGD FOR PEG PLACEMENT 
        FT PERC PLACEMENT OF G TUBE 
        FT REPOS TUBE THRU DUODENUM 
        FT SM INT ENDO CONV G-J TUBE 
        FT SM INT ENDO J TUBE PLACE 
        HEART RATE VAR. ANALYSIS 
        HEMODIALYSIS, ONE EVAL 
        HEMODIALYSIS, REPEATED EVAL. 
        HOLTER 
        I & D /DEBRIDEMENT 
        ICD IMPLANTATION 
        ICD INTERROGATION 
        ILEOSCOPY THROUGH STOMA 
        ILEOSCOPY W/ BIOPSY 
        INFUSION 1-8 HRS. 
        INFUSION TO 1 HR. 
        INJ FOR ANGIOGRAPHY 
        INJ FOR AV BYPASS GRAFTS 
        INJ TENDON/LIGAMENT/CYST 
        INJECTION, CARDIAC CATH 
        INTRA-ATRIAL PACING 
        INTRA-ATRIAL RECORDING 
        INTRAVENTRICULAR PACING 
        INTRODUCTION OF NEEDLE/CATH 
        IV FLUID THERAPY 
        IV INFUSION 
        IV PUSH 
        IV THER. 1-8 HRS. 
        IV THER. UP TO 1 HR. 
        LASER SURGERY (NOT YAG) 
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        LEFT HEART CATHETERIZATIION 
        LEFT VENTRICULAR RECORDING 
        LIVER BIOPSY 
        LUNG COMPLIANCE 
        MECHANICAL VENTILATION 
        METHACHOLINE CHALLENGE 
        MONITOR W/ REVIEW & REPORT 
        OVER GUIDE WIRE 
        PACEMAKE IMPLANTATION 
        PACEMAKER 
        PACEMAKER FOLLOW UP 
        PACEMAKER, RHYTHM STRIP 
        PARACENTESIS 
        PERIPH BLOOD SMEAR INTERPRET 
        PHLEBOTOMY 
        PLACE CATHETER IN VEIN, HEMO 
        PLEURODESIS 
        PNEU BALLOON (30MM+) ACHALASIA 
        PROC ABLATION (OTHER) 
        PROC BIOPSY 
        PROC CONTROL BLEEDING 
        PROC DIAGNOSTIC (BRUSHINGS) 
        PROC DILATION 
        PROC HOT BIOPSY(IES) 
        PROC REMOVAL FB 
        PROC SNARE 
        PROC TUMORS, MULT (HOT/SN/BI) 
        PROCTOSCOPY 
        PROGRAMMED STIMULATION/PACING 
        PSEUDOFOLLICULAR SCAN 
        PULMONARY ARTERY CATHETER 
        PULMONARY FUNCTION INTERPRET 
        PULMONARY PROCEDURES 
        PULSE OXIMETRY MULTIPLE REHAB 
        PULSE OXIMETRY SINGLE REHAB 
        PULSE OXIMETRY, MULTIPLE 
        RHEUMATOLOGY PROCEDURES 
        RIGHT HEART CATHETERIZATION 
        RIGHT VENTRICULAR RECORDING 
        RT & LT HEART CATHETERS 
        SB ENDO W/ABLATION 
        SB ENDO W/BLEEDING CONTROL 
        SB ENDO W/FB REMOVAL 
        SB ENDO W/HOT BIOPSIES 
        SB ENDO W/INCL ILEUM 
        SB ENDO W/INCL ILEUM,BIOPSY 
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        SB ENDO W/INCL ILEUM,BLD CONT 
        SB ENDO W/TUMORS (SNARE) 
        SCREENING, MAMMOGRAM 
        SCREENS AND INJ, ANTI-COAG 
        SLOW VITAL CAPACITY 
        SMALL BOWEL ENDOSCOPY 
        SMALL BOWEL ENDOSCOPY,BIOPSY 
        SOUND/BOUGIE;SINGLE/MULT 
        SPIROMETRY 
        SPIROMETRY, PRE & POST 
        STO ABLATION 
        STO BIOPSY 
        STO CONTROL HEM. 
        STO DIAG/BRUSHING 
        STO FOREIGN BODY 
        STO HOT BIOPSY(IES) 
        STO SNARE 
        STOMA 
        STRESS TEST, ECHO IMAGING 
        STRESS TEST, EXER (NON-IMAGE) 
        STRESS TEST, NUCLEAR IMAGING 
        SUBCUT./IM 
        SYMPTOM LIMITED EXERCISE TEST 
        THORACENTESIS 
        THORACIC GAS VOLUME 
        THORACOSTOMY 
        THRESHOLD TEST (DUAL) 
        THRESHOLD TEST (SGL) 
        TILT TABLE TEST FOR SYNCOPE 
        TRANS. BLOOD 
        TRANS. INDWELL. VEN. ACC. CARE 
        TRANS. THERAPEUTIC APHERESIS 
        TRANSFUSION 
        VENIPUNCTURE (ROUTINE), HEMO 
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17. Appendix C - Instrument Processing Routines 
 
The following is a listing of the processing routines associated with each instrument. 
 
Instrument Name: Processing Routine: 
CLINIVISION MDHL7R1 
Muse  MDHL7M1 
Muse EKG  MDHL7M1 
Muse Exercise  MDHL7M1 
Muse Holter  MDHL7M1 
Muse Pacemaker EKG  MDHL7M1 
OLYMPUS  MDHL7E 
OLYMPUS Bronchoscopy  MDHL7E 
OLYMPUS Colonoscopy  MDHL7E 
OLYMPUS EGD  MDHL7E 
OLYMPUS EGDPEG  MDHL7E 
OLYMPUS ERCP  MDHL7E 
OLYMPUS Endo Ultrasound MDHL7E 
OLYMPUS Enteroscopy MDHL7E 
OLYMPUS Liver Biopsy  MDHL7E 
OLYMPUS Paracentesis MDHL7E 
OLYMPUS Sigmoidoscopy MDHL7E 
SMC MDHL7P1 
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